
 
 

 

GD System  
The Partner of a world in evolution  

 

 
 

FileDirector 2.0 
Enterprise & SBE 

Dieter Spielberg DMS GmbH 

 

 

 

USER GUIDE 

 
 

 

© 2009 GD System, Inc. 

7811 Louis-H Lafontaine, Suite 200 

Montréal (Québec) 

Canada H1K 4E4 

http://www.gdsystem.ca 

 

 

Prepared by:                     Vicky Edmond  

Document version:          1.1 

Date:                                 14/01/2009 

Revised by:                      Henry Gudiño 

          Sales@gdsystem.ca 

 

 



                    Document: FileDirector 2.0 – User Guide 

                     Client Name: N/A 

 

 

 FileDirector 2.0                                          Software License Agreement       © GD System Inc.  2009                                     

Date Version Document Reference # 

January 14, 2009 1.1 GDS-FileDirector-2.0 

Page 1 

 
 

 

Notification 
 
Disclaimer: GD System, Inc. & Dieter Spielberg DMS GmbH makes no 
representation or warranties with respect to the contents or use of 
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warranties of merchantability or fitness for any particular purpose. 
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publication and to make changes to its content, at any time, without 
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merchantability or fitness for any particular purpose. Further, 
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Proprietary & Secure Information 
 

Copyright: © GD System, Inc. and © 2008 Dieter Spielberg DMS GmbH. 
All Rights Reserved. No part of this document may be reproduced, 
transmitted or stored in any form or by any means, electronic or 
mechanical, for any purpose, without the express written permission 
of Dieter Spielberg DMS GmbH. FileDirector is a registered trademark 
of Dieter Spielberg Document Management Systems GmbH. Microsoft, 
Windows, Windows NT and Windows 2000 are either registered trademarks 
or trademarks of Microsoft Corporation. Other product and company 
names mentioned herein may be trademarks of their respective owners. 

History 
 

Version Publish by Issued date Comments 

    

    

    

 

 

 



FileDirector 2.0 Software Licence Agreement    3 

Content 

Software Licence Agreement 10 

FileDirector Software Licence Agreement...............................................10 
Disclaimer................................................................................................13 

Working with WinClient 14 

About FileDirector WinClient ................................................................................14 
How are documents archived?.............................................................................14 
Establish connection to the Server.......................................................................15 

Using a proxy server ...............................................................................15 
Connected or disconnected (online-/offline).........................................................16 

Offline – Mode .........................................................................................16 
Online – Mode .........................................................................................17 
Working with the WinClient in a central server environment...................17 
Controlling of licences .............................................................................18 

WinClient Desktop................................................................................................20 
Control box ..............................................................................................20 
Document lists.........................................................................................20 
Document display / Display window........................................................21 
Arrange windows.....................................................................................22 
Setup button bars ....................................................................................22 

First steps 24 

Open cabinet ........................................................................................................24 
Open cabinet manually............................................................................24 
Open cabinet automatically.....................................................................24 

Open document list ..............................................................................................24 
Search results .........................................................................................24 
Local Documents.....................................................................................25 
Personal folder ........................................................................................25 
Closing of document lists ........................................................................25 

Searching in Cabinets 26 

General concerning searching .............................................................................26 
Clear index fields.....................................................................................26 
Start search .............................................................................................26 
Start extended search .............................................................................26 
Info Search ..............................................................................................26 
Start full text search.................................................................................27 
Search history .........................................................................................27 

Search parameter.................................................................................................28 
Searching using index fields ................................................................................28 
Search using OR combinations............................................................................28 
Input assistance for index entry ...........................................................................29 

Search in inverted commas.....................................................................29 
MRU-Lists................................................................................................29 
Keyword lists ...........................................................................................30 
Date entry................................................................................................30 
Memo fields .............................................................................................30 
ODBC database links *............................................................................30 
Manual indexing using OCR zone recognition........................................31 

Full text search .....................................................................................................31 



4     Software Licence Agreement FileDirector 2.0 

Searching multiple words in full text using AND, OR, OR NOT..............31 
Full text search combined with index fields.............................................31 

Document lists 32 

Types of document lists........................................................................................32 
Search results ......................................................................................................32 
Local documents ..................................................................................................33 
Personal list ..........................................................................................................34 
Document status ..................................................................................................35 

Status New ..............................................................................................35 
Status Archived .......................................................................................35 
Status Checked out .................................................................................35 
Status Read only .....................................................................................35 
Send ........................................................................................................36 
Deleted ....................................................................................................36 
Status ......................................................................................................36 

Display modes of document lists..........................................................................36 
Handling of document types lists ............................................................36 
Handling of lists for document display.....................................................37 
Fit columns during run-time.....................................................................38 
Set filter for resulting list ..........................................................................38 
Arrange Tabs / Display lists side by side ................................................39 
View documents side by side..................................................................40 

Display of documents ...........................................................................................40 
About documents ....................................................................................41 
Display options ........................................................................................41 
Thumbnail view .......................................................................................42 
Select document for display/navigate .....................................................42 
Select page of document for display .......................................................42 
Tools for page display .............................................................................43 

Selecting documents ............................................................................................44 

Check In and Check Out 45 

Why check in or check out documents.................................................................45 
Check In documents.............................................................................................45 

Automatic check in / Setting in Options...................................................45 
Mandatory fields and test during check in...............................................47 
Protected fields........................................................................................47 
Cancel Check in of several documents...................................................47 

Check out documents...........................................................................................48 
Undo Check out....................................................................................................48 
Revisions..............................................................................................................49 

Display Revisions ....................................................................................49 
Change Revision/ Check out...................................................................49 
Delete revision.........................................................................................49 
Print Revisions ........................................................................................49 
Document type without revisions (mail box)............................................50 
How is a revision stored? ........................................................................50 

Editing of documents 50 

Editing - General ..................................................................................................50 
Editing of document-index information.................................................................50 

Editing of index data for a document.......................................................51 
Moving of a document to a different document type ...............................51 
Editing of index for several documents ...................................................51 
Simultaneous changing of an index field for several documents............52 
Indexing with keyboard............................................................................52 
Copy and move with drag & drop............................................................52 



FileDirector 2.0 Software Licence Agreement    5 

Indexing with predefined OCR forms ......................................................53 
Add columns............................................................................................54 
Automatic check in of documents ...........................................................54 

Combine documents ............................................................................................54 
Combining of archived documents..........................................................54 
Combining of new documents.................................................................55 
Combining of new and archived documents ...........................................55 

Splitting of documents ..........................................................................................55 
Duplicating of a document....................................................................................55 
Convert a document .............................................................................................56 
Link to a document ...............................................................................................56 
Creation of an empty document ...........................................................................56 
Deleting of documents and pages........................................................................57 

Delete single pages of a document.........................................................57 
Recovering of a deleted page .................................................................57 
Remove documents from a document list...............................................57 
Delete documents from server ................................................................58 
Reactivate deleted documents................................................................58 

Automatic Indexing (Forms recognition) ..............................................................58 
Indexing from external applications (Codeless Connector) .................................58 
Security on document level ..................................................................................59 
Annotations ..........................................................................................................61 

Annotations – General.............................................................................61 
Display/hide annotations .........................................................................61 
Select annotation type.............................................................................61 
Black area ...............................................................................................61 
White area ...............................................................................................62 
Text..........................................................................................................62 
Line..........................................................................................................62 
Arrow .......................................................................................................62 
Highlight ..................................................................................................63 
Note .........................................................................................................63 
Hyperlink .................................................................................................63 
Signature .................................................................................................63 
Stamp *....................................................................................................63 
Annotation as hyperlink to another document.........................................64 
Move annotations ....................................................................................64 
Delete annotation ....................................................................................64 

Print Documents...................................................................................................64 
Printing - General ....................................................................................64 
Printing of a single document..................................................................65 
Print several documents..........................................................................65 
Print one page of a document .................................................................65 
Print several pages of a document..........................................................65 
Copy/print area........................................................................................65 
Print document lists .................................................................................66 
Export and print list..................................................................................66 

Save document as file ..........................................................................................66 
Save whole document .............................................................................66 
Assign file name automatically................................................................66 
Save one page ........................................................................................66 
Save a selection of pages .......................................................................66 
Save documents in different formats with/ without OCR text 
recognition...............................................................................................67 

Scanning documents 68 

Scanning - General ..............................................................................................68 
Supported scanners .............................................................................................68 

Directory scan .........................................................................................68 



6     Software Licence Agreement FileDirector 2.0 

Rights for scanning...............................................................................................68 
Scan profiles.........................................................................................................69 

Change scanner settings ........................................................................69 
Set automatic value.................................................................................69 
Use OCR-/Forms recognition..................................................................69 
Selection of document types ...................................................................70 

Scanning of documents........................................................................................70 
Scan multipage documents.....................................................................70 
Scan single pages ...................................................................................70 
Append pages .........................................................................................71 
Insert pages.............................................................................................71 
Replace one page ...................................................................................71 
Replace all pages....................................................................................71 
Stop scanning..........................................................................................72 

Import documents.................................................................................................72 
Import list / Import - Index .......................................................................72 

Special scan options ............................................................................................74 
Skip first page with barcode (separation sheet) ......................................74 

Component Service (Office Link) 75 

What is an electronic document (Edoc)? .............................................................75 
How are Edocs stored in FileDirector?.................................................................75 
How can Edocs be displayed? .............................................................................75 

Selection of a page when displaying Edocs............................................76 
Tools for page display .............................................................................76 

Indexing of electronic documents.........................................................................77 
Requirements ..........................................................................................77 
Indexing from Microsoft Office ................................................................77 
The index capture....................................................................................77 
Revising of electronic documents ...........................................................78 
Several fields as a unique index .............................................................78 
Office Quick Start ....................................................................................79 
Indexing using Drag & Drop ....................................................................79 
Send to FileDirector.................................................................................79 

Capture Emails from Outlook ...............................................................................80 
Save email attachments as separate pages ...........................................80 
Save attachments as separate Documents ............................................81 

Sending and receiving 82 

Send documents by Email....................................................................................82 
Sending by Email - General ....................................................................82 
Append as *.pdf - format .........................................................................82 
Configuration of filename for Email appendage......................................82 
Sending of a single document.................................................................83 
File name of the appended document.....................................................83 
Sending of several documents................................................................83 
Sending selected documents ..................................................................83 
Sending of one page of a document .......................................................83 
Sending of selected pages of a document ..............................................84 

Send eMail as link ................................................................................................84 
Send Documents to users ....................................................................................84 

The personal folder .................................................................................84 
Sending of documents.............................................................................84 
Selection of a range of documents..........................................................84 
Selection of single documents ................................................................84 
Notification...............................................................................................84 
Send to … Info ........................................................................................85 



FileDirector 2.0 Software Licence Agreement    7 

Process management * 86 

What is process management..............................................................................86 
Send to process ...................................................................................................86 

Manual sending of documents to processes...........................................86 
Automatic sending of documents to processes ......................................87 

Receiving of documents from a process..............................................................87 
Process actions .......................................................................................87 
No action .................................................................................................87 
Confirm view............................................................................................88 
Comment document ................................................................................89 
Approve/Reject document.......................................................................90 
Check user actions..................................................................................90 
Keep document .......................................................................................90 

Process Status .....................................................................................................92 
Process Info ............................................................................................92 
Cancel Process .......................................................................................92 

Signing of Documents with signpad .....................................................................92 
Install sign pad ........................................................................................93 
Setup signatures .....................................................................................93 
Deleting of signatures..............................................................................94 

Set up absence ....................................................................................................95 

Information of documents 96 

Logging of document information.........................................................................96 
Info: Document .....................................................................................................96 
Info: History ..........................................................................................................96 
Info: Processes.....................................................................................................97 
Info: Send to .........................................................................................................97 
Page-Information..................................................................................................98 

General settings/Options 99 

General.................................................................................................................99 
Open last used cabinet..........................................................................100 
Remove new documents after check-in................................................100 
Remove revised documents after check-in...........................................100 
Remove local documents after sending to process ..............................101 
Don’t remove from search result list......................................................101 
Auto. Check-In new documents ............................................................101 
Auto. Check-in new documents after edit .............................................101 
Auto. Check-in revised documents after edit ........................................101 
Reminder to check in new documents on program exit ........................101 
Reminder to check in documents on program exit................................101 
Check integrity of unsigned documents ................................................101 
Language ..............................................................................................102 
Delete MRU List ....................................................................................102 

Misc. ...................................................................................................................102 
Convert to PDF......................................................................................103 
Assembling of file name for Email attachement....................................103 
Exact scale print ....................................................................................104 
Print using smart page rotation .............................................................104 
Reset Zoom when displaying new page ...............................................104 
Use area post-indexing .........................................................................104 
Show post scan options ........................................................................104 
Show line number in document lists......................................................104 
Rotational line colours in document lists ...............................................105 
Show documents immediately ..............................................................105 
Allow floating control and list windows ..................................................105 
Custom quick start program ..................................................................105 



8     Software Licence Agreement FileDirector 2.0 

Notification..........................................................................................................105 
Disable client notification.......................................................................106 
Scheduler based passive notification....................................................106 

Signatures ..........................................................................................................107 
Sign documents.....................................................................................107 
Using of a scanned and stored personal sign.......................................108 
Define electronic signature for processes * ..........................................108 

Cache (local) ......................................................................................................109 
Purge Cache after program exit / logout ...............................................109 
Document storage cache (Cache Directory) .........................................109 

Connection .........................................................................................................109 
Server URL............................................................................................110 
Automatically Log-In..............................................................................111 
Set up Image .........................................................................................111 

Help ....................................................................................................................112 
Content / Index/ Search ........................................................................112 
Check for updates .................................................................................112 
Info.........................................................................................................112 

Keyboard control ................................................................................................112 

Plug-ins for WinClient 113 

What is a Plug-in? ..............................................................................................113 
Installation of Plug-ins ...........................................................................113 
Requirements for OCR Plug-ins............................................................113 
Update of the plug-Ins for version 1.5 ...................................................113 

Point and Shoot (OCR Index – Zone recognition) .............................................113 
Manual OCR zone recognition ..............................................................114 

OCR-Calculator ..................................................................................................114 
Adding of units and prices.....................................................................114 

CallTo – Reading of telephone numbers............................................................116 
Setting of a default country code:..........................................................116 

HitListDocumentExport (Export Documents) .....................................................116 
Global Count (manual global counter) ...............................................................118 

Usage in WinClient................................................................................118 
ResponseWriter (generate response writings)...................................................118 

Example ................................................................................................119 
Installation .............................................................................................119 
Configuration .........................................................................................119 
Procedure/usage after configuration: ....................................................120 

ClearUI – Reset user interface...........................................................................122 

Create Retrieval CD/DVD * 123 

What is a Retrieval CD/DVD? ............................................................................123 
Requirements/Tickers ........................................................................................123 
Creation of a retrieval CD...................................................................................123 

Target folder ..........................................................................................124 
Include revisions / history......................................................................124 
New target folder after:..........................................................................124 
General information...............................................................................125 
Certificate ..............................................................................................125 
Media ID ................................................................................................125 
Licence FD Retrieval .............................................................................125 
Create a CD/DVD..................................................................................125 

FileDirector Retrieval Client................................................................................125 
Installation .............................................................................................125 
Open cabinet with retrieval client ..........................................................126 

The local cache 127 



FileDirector 2.0 Software Licence Agreement    9 

Storage location .................................................................................................127 
Structure of the local cache................................................................................127 

Cache is deleted automatically .............................................................127 
Office Link ..........................................................................................................128 

Component Service...............................................................................128 

Document formats that can be displayed 129 

Document formats ..............................................................................................129 
Avoiding Stellent Viewer in WinClient ................................................................129 

Settings for the Client ............................................................................129 
Settings for all Clients before the installation ........................................130 

 
 
* All options with Asterisk are NOT available in the SBE (Small Business Edition) version. 



10     Software Licence Agreement FileDirector 2.0 

Software Licence Agreement 

FileDirector Software Licence Agreement 
IMPORTANT: Read this agreement before installing FileDirector. By installing 
FileDirector you are deemed to agree to be bound by this agreement. 
This license agreement is a legal document between you and Dieter Spielberg 
Document Management Systems GmbH. If you do not agree to the terms of this 
agreement return the software CD and accompanying documentation (the 
"Documentation") and other items to the place from where you obtained them for 
a refund before they are marked or damaged in any way. 
In consideration of the right to use the Software you agree to abide by the terms 
and conditions of this agreement. 

1. GRANT OF LICENSE 
The Software consists of the software modules by: 
a) Dieter Spielberg Document Management Systems GmbH, a German public 
listed company having its place of business at Wanheimer Str.593, 47249 
Duisburg, Germany ("Spielberg"); 
b) Microsoft Corp., a Washington Corporation having its place of business at 1 
Microsoft Way, Redmond, WA 98052-6399, USA ("Microsoft"); 
c) Stellent Inc., an Illinois Corporation having its place of business at 330 N. 
Wabash Ave., 15th Floor, Chicago, IL 60611, USA ("Stellent"); 
d) MICROPLEX Trading GmbH, a German Company having its place of business 
at Leipziger Chaussee 191g, 06112 Halle, Germany("Microplex"); 
e) ScanSoft B.V., a Dutch Company having its place of business at Randstad 22-
139, 1316 BW Almere, Netherlands ("ScanSoft"); 
f) Developer Express Inc., a Nevada company having its place of business at 
6340 Mcleod Dr. Suite1, Las Vegas, NV 89120, USA (“DevExpress”); 
g) Pixel Translations a Division of Captiva Software Corporation, a Californian 
company having its place of business at 1299 Parkmoor Drive, San Jose, 
California 95126, USA (“Pixel”). 
You understand and acknowledge that any software module included in the 
Software may have utility with or be able to be called by other software and/or 
hardware, which Spielberg considers to be an unauthorised use of the Software. 
Accordingly, you agree that you will use such software modules only as part of the 
Software and not in conjunction with, or as part of, or as a component of other 
software and/or hardware which makes calls to such software modules. 
Spielberg grants you the personal non-exclusive rights: 
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a) For a single-user version of the Software, to install and use the Software for 
internal purposes only on a single computer (the Software is considered in use 
when it is installed in the temporary memory, i.e. RAM, or the permanent memory, 
i.e. Hard Disk Drive). 
b) For a multi-user version of the Software, to install and use the Software for 
internal purposes only for the number of computers or simultaneous users 
identified in the Installation Configuration sheet of the Software package (for 
example, if you have purchased a 5-User license you may install the Software for 
simultaneous use by up to 5 Users on a network). 

2. BACKUP COPY 
a) You may make whatever copies you deem appropriate from the FileDirector 
"delivery" Compact Disc, the Programs, Example Files and any other promotional 
material that may be included thereon. The Application Manual, or any part 
thereof, may be reproduced in sufficient quantity to support only the number of 
users licensed to you and no more. You must reproduce and include on the 
backup copy the copyright notice and other ownership or proprietary legends that 
are on the original copy of the Software. 
b) You may NOT make or attempt to make any copy whatsoever of the 
FileDirector License held on the dongle. ANY ATTEMPT TO COPY, TRANSFER 
OR RESTORE THE LICENSE MAY CORRUPT THE ENABLING LICENSE. The 
License, once enabled on the dongle, represents the full purchase value of the 
license to use the FileDirector Software. The enabled License can be manipulated 
ONLY by the commands within the FileDirector application. 

3. RESTRICTIONS 
a) You may not market, distribute or transfer the Software or the Documentation 
to others, or electronically transfer the Software from one computer to another 
over a network except as expressly provided herein. 
b) You may not de-compile, reverse engineer, disassemble or otherwise reduce 
the code of the Software to a human perceivable form. 
c) You may not modify, adapt, translate, rent, lease or loan the Software or the 
Documentation or create derivative works based on the Software or the 
Documentation. 

4. OWNERSHIP AND COPYRIGHT 
Spielberg, Microsoft, Stellent, Microplex, ScanSoft, DevExpress and Pixel reserve 
all rights to their respective software modules of the Software and the 
Documentation. The Software and the Documentation is copyrighted. 
Unauthorised copying of the Software, including portions thereof, or the 
Documentation is expressly forbidden. 

5. EXPORT CONTROL 
You agree that the Software and Documentation will not be shipped, transferred 
or exported into any country or used in any manner prohibited by the United 
States Export Administration Act or any other applicable export control laws, 
restrictions or regulations of the countries involved. 

6. SUPPORT AND UPDATES 
a) Spielberg, Spielberg's subsidiaries or affiliates, their distributors and dealers 
are not responsible for maintaining or helping you to use the Software and the 
Documentation, excepting where agreements have been entered into between 
specific parties, i.e. Spielberg: Distributor, Distributor: Dealer, Dealer: End User. 
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b) No updates, fixes or support will be made available for the Software and 
Documentation other than by publishing such revisions on the Spielberg web site: 
http://www.spielberg.de or http://www.filedirector.com 
c) Any updates, fixes or support will be made available on the said web site solely 
at the discretion of Spielberg, who is under no obligation whatsoever so to do. 

7. LIMITED WARRANTY AND DISCLAIMER OF INDEMNITY 
Limited Warranty. The Software and documentation is provided "as is" without 
warranty of any kind, either express or implied, including, but not limited to implied 
warranties of merchantability and fitness for a particular purpose. The entire risk 
as to quality and performance of the Software and documentations is with you. 
Should the Software prove defective you (and not Spielberg, Spielberg's affiliates, 
their distributors or dealers) assume the entire cost of all necessary servicing, 
repair or correction. Some states or jurisdictions no not allow the exclusion of 
implied warranties, so the above exclusion may not apply to you. This warranty 
gives you specific legal rights and you may also have other rights which vary 
according to state or jurisdiction. 
Spielberg, Spielberg's affiliates, their distributors and dealers do not warrant that 
the functions contained in the Software will meet your requirements or that the 
operation of the Software will meet your requirements or that the operation of the 
Software will be uninterrupted or error free. 
However, Spielberg or Spielberg's affiliates warrants a compact disc or diskette on 
which the Software is stored to be free from defects in materials and workmanship 
under normal use for a period of ninety (90) days from the date you purchased the 
same, as evidenced by a receipt or otherwise. Some states or jurisdictions do not 
allow limitations on duration of an implied warranty, so the above limitation may 
not apply to you. 

CUSTOMER REMEDIES 
Spielberg's entire liability and your exclusive remedy shall be the replacement of 
the Compact Disc and/or Diskette not meeting the LIMITED WARRANTY and 
which is returned to Spielberg or Spielberg's marketing affiliate, ScanFile 
International Limited, with a copy of your receipt or otherwise. The LIMITED 
WARRANTY is void if failure of the Compact Disc has resulted from accident, 
abuse or misapplication of the software. 
No liability for consequential damages. In no event shall Spielberg, or Spielberg's 
affiliates, their distributors or dealers be liable for any damages whatsoever 
(including without limitation, direct or indirect damages for personal injury, loss of 
business profits, business interruption, loss of business information, or other 
consequential or incidental damages) arising out of the software, the use thereof 
or inability to use the software even if Spielberg, Spielberg's affiliates, their 
distributors or dealers has been advised of the possibility of such damages. Some 
states or jurisdictions do not allow the exclusion or limitation of liability for 
consequential or incidental damages, so the above limitation may not apply to 
you. 
Disclaimer of indemnity. Spielberg, Spielberg's affiliates, their distributors and 
dealers shall have no obligation to indemnify you against any claim or suit brought 
to you by a third party alleging that the Software or the use thereof infringes any 
intellectual property of such third party. 
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8. TERM 
This agreement is effective upon the installation of FileDirector Server and Client 
and remains in effect until terminated. You may terminate this agreement by 
destroying the Software and any copy thereof. This agreement will also terminate 
if you fail to comply with any of the terms of this agreement. In addition to 
Spielberg enforcing its legal rights, you must then promptly destroy the Software 
and any copy thereof. 

9. ACKNOWLEDGEMENT 
By selecting the 'Yes, I accept the agreement' option, you acknowledge that you 
have read this agreement, understand it and agree to be bound by its terms and 
conditions. You further agree that this agreement is the complete and exclusive 
statement of agreement between you and Spielberg concerning the subject matter 
hereof, which supersedes any proposals or prior agreements, oral or written, and 
any other communication between you and Spielberg relating to the subject 
matter hereof. No amendment to this agreement shall be effective unless signed 
by a duly authorised representative of Spielberg. 
 
Should you have any questions concerning this agreement, or if you desire to 
contact Spielberg for any reason, please write to your authorised supplier 
requesting that they pass your correspondence to ScanFile International Limited, 
the marketing affiliate of Dieter Spielberg. 

Disclaimer 
This document was created with utmost accuracy. Nevertheless we cannot 
guarantee that it is free of errors. Therefore we cannot take responsibility resulting 
from wrong or misleading descriptions or their consequences. 
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Working with WinClient 

About FileDirector WinClient 
 

 
 
FileDirector WinClient is the main application which normal users will call when 
working with documents in FileDirector cabinets. With FileDirector WinClient 
documents can be scanned, retrieved and edited. 
FileDirector WinClient can be used with or without connection to the FileDirector 
server (online or offline). In offline mode many operations can be accomplished 
without occupying a license. 
 

How are documents archived? 
FileDirector stored documents in cabinets. There may be several cabinets 
arranged in your organisation; a user is only allowed to work with those cabinets 
to which he was granted access. 
 
Each cabinet contains different document types. Index fields are assigned to the 
document types, which should be filled according to the filing requirements of your 
documents. The retrieval information is entered into the index field. Documents 
are stored with this index data for easy retrieval. 
 
Although a user has access to a cabinet, he is only able to work with those 
document types in a cabinet to which he was granted access. Additionally 
different rights can be granted per document type, a user may for example store 
documents in one document type but is only allowed to retrieve and display in a 
different document type.  
 
Documents scanned in black and white are stored in TIFF; coloured documents 
are stored as JPEG compressed files. 
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Electronic documents (EDOCS) are stored in original format and can be viewed 
by an implemented viewer even if the relevant application is not installed. If the 
relevant software is installed (for example WORD) documents can additionally be 
edited. Changes are stored in regular document types as revisions, the original 
version of the document remains stored. 
 

Establish connection to the Server 
 
If this window appears when starting FileDirector WinClient you have to specify 
the connection to the FileDirector server. For the server URL contact your 
administrator. 
 

 
 
More information and explanations about the settings: → Connection 
 

Using a proxy server 
 

If it is not possible to establish a connection between the WinClient and the server, the 
reason might be a proxy server. 
 
 
Further details can be found in the chapter →„Separate Settings in WinClient 
despite Proxy Settings“of the installation manual. 
 
 
 



16     Working with WinClient FileDirector 2.0 

 
 
 

Connected or disconnected (online-/offline) 
 
FileDirector WinClient is a locally installed FileDirector module. This module 
connects and logs on the server in order to retrieve in a cabinet. Additionally 
documents can be scanned, indexed and annotations can be stored on 
documents. Information about the cabinet and the access rights are copied to the 
local cache of the PC when opening the cabinet for the first time. 
 
See → Local cache  

Offline – Mode  

 
 
In Offline mode the connection to the FileDirector server is cut off. Therefore no 
documents can be retrieved from the server and no new documents can be sent 
to the server. New documents however can be created locally and local 
documents can be edited. If during log on for example a wrong password was 
specified or connection to the server failed for whatever reasons a log on in offline 
mode is established. Make sure you are in online mode, if you want to accomplish 
server based actions (search, check in, etc.). 
 
The administrator can deactivate the offline-mode for users in the client 
configuration to force that they use the WinClient only in online with connection to 
the server. 
 

Work offline with local documents 
As from version 1.4 not all pages are downloaded to the local cache to improve the 
performance if only one page is displayed. At first only the first page is downloaded to the 
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local cache and then every page which is displayed. If you want to work offline with the 
document later, all pages of the document must be downloaded to the local cache. In 
order to do that you must switch the mode to “offline” after downloading the documents 
(Click on symbol “ready” in the left edge (corner)). If there are uncompleted documents in 
the local cache, you are asked if you want to download all documents to work offline with 
them. If you approve (confirm) with “yes”, you can work offline with these documents 
without connection to the server. 
 
Hint: 
Downloaded documents which are not checked out can only be changed and checked in 
again if they are not revised in the meantime on the server. 
 

Online – Mode  

 
 

If a connection to the FileDirector server exists – Online mode – each accessible 
function can be executed, for example retrieve documents from server or send 
documents to the server. 
 
To change from Offline mode to online mode click to the symbol in the lower left 
corner of the WinClient window or select menu File → Offline. 

Working with the WinClient in a central server environment 
Since version 2.0 there is the possibility of installing the WinClient on the server and 
starting it by a browser on a client machine. In order for this to work the .NET Framework 
2.0 must be installed on the client. The same functions are available as if the WinClient 
had been directly installed.  
The only restriction is that no off-line work is available, since a connection to the server 
has to be established by the browser in order to start the WinClient. 
After the WinClient was correctly installed on the server, the function „Add trust to this site 
to allow execution of browser based application“ needs to be executed to setup a trust 
relation to the server. 
  
Afterwards open the installation site (http://[servername]/filedirector) and execute “Start in 
browser”. This will call the link http://[servername]/filedirector/WinCWeb/default.htm 
 
 

 
 

http://%5bservername%5d/filedirector/WinCWeb/default.htm
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If the WinClient doesn’t start on the server this can be caused by the following (please 
ask your administrator for further information): 
- .NET 2.0 was not correctly installed on the client  
- the branding wasn’t executed before the WinClient was installed on the server. 
Therefore the server URL wasn’t written into the App.xml 
- “Add Trust” wasn’t executed on the client machine 
- the security settings of the IIS directory WinCWeb prohibit access 
 

Controlling of licences 
FileDirector uses different groups: 
The group fd-admins, fd-scan, (prior:fd-user), fd-scan-named (prior: fd-prio-user), fd-user-
named und fd-user (concurrent) (prior::fd-web-user). The users are assigned to these 
groups from the administrator. 
 
Only as many users can connect to the system and logon as licenses are 
available. After 30 minutes of idle time (default value, can be specified) WinClient 
automatically logs off and frees the license for another user. The number of 

licences can be displayed in WinClient under  → Info. It is possible to specify 
more users in the FileDirector groups than licences available. In this case it is 
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possible, that a user cannot connect to the system because all licences are used. 
Logon will only be possible if another user logs off. 
 
Group fd-prio-user should only contain as many users as Prio-licenses are 
available. The users specified here have always access to the system; e.g. to 
scan, index and check in documents for retrieval by other users.  
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WinClient Desktop 
 

 
 
 
If WinClient is started and a cabinet was opened, a standard menu with icon bars 
and a control box is displayed. If a search was executed, the result is displayed in 
a hitlist. If you double click a document in that list, it is displayed in an image 
display window. 

Control box 
If you open a FileDirector cabinet, the control box is displayed. In this control box 
the functions can be executed, which are allowed for the relevant user. 
I this box the document types are selected, the relevant index fields then 
automatically displayed. The tabs of the control box allow switching between 
Search, Edit and Scan. These tabs can be invisible, if the relevant user is not 
allowed to execute this function. The icons below change depending on the tab 
selected and provide the necessary functionalities of that area. 
 

Document lists 
Document lists are displayed in an own window. Three different document lists 
are available: 
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Search results 
The list Search results contains a list of documents found on the server by a 
search operation. In order to execute a search operation, the WinClient must be in 
Online mode. 

Local documents 
The Local documents list shows documents stored on your local computer, for 
example new documents, which are not yet checked into the FileDirector server. 
Documents downloaded from the server are also stored here as local copies. 
Such a downloaded copy cannot be checked in. Documents which were displayed 
are downloaded to a local cache. 
 
Hint: 
In menu Extras → Options → Cache → Purge cache after program end it is 
specified, if all displayed documents are automatically deleted when ending 
WinClient. This does not affect new documents, checked out or downloaded 
documents. If WinClient is not ended, the cache data are deleted automatically 
after 12 hours, if this option is ticked. 

Personal folder 
The list of the personal folder contains documents which were sent to you by 
other FileDirector users or which have been sent automatically to you by a 
process if your account is part of a process step. 
 

Document display / Display window 
The actual document is displayed in the document window. Using a basic 
configuration with WinClient only the scanned documents can be displayed. If you 
have FileDirector Component Service installed, additionally more than 200 file 
formats can be displayed, including all Microsoft Office formats, Emails or CAD 
drawings. 
Editing of pages is executed in display window as well, if allowed for you. 
Annotations can be added or pages revised. 
 
Hint: 
The document actually displayed is always marked green in the document lists. 



22     Working with WinClient FileDirector 2.0 

Arrange windows 
 

 
 
In order to arrange control box, document display and document lists clearly, a 
fixed arrangement can be selected in menu Windows. 
 
In section Arrange tabs more possibilities are listed to setup the desktop of your 
installation. 

Setup button bars 
The setup of the button bars can be defined, if it is allowed for the relevant user. 
The rights are predefined from administrator. The administrator can predefine the 
menus and the options for the users, so that no changes are allowed for the client. 
 
 

 
 
If there are small arrows between the button bars, a fast arrangement can be 
specified. If no arrows exist, it is possible (if rights are sufficient) to call the setup 
menu by double clicking the free area of that bar. 

Switch button bars on and off: 
Click to the arrow of the relevant button bar → Add or remove buttons → Edit 
and set or remove the tick in front of the relevant button bar. 
 

Create own button bar: 
Click to the arrow of a button bar → Add or remove buttons → Customize… 
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In tab Toolbars a new toolbar is created by clicking to New. A new empty toolbar 
is created in your menu. In tab “Commands” commands can be selected and 
added to the toolbar by drag and drop. 
 

Options for toolbars 

 
 
 
Specify under Options if menus are always displayed completely or if they should 
only be displayed after a short delay. If the buttons appear too small on your 
screen – because you are using a very high screen resolution - you can switch to 
display Big Icons. 
Tooltips can automatically be shown on toolbars if the mouse cursor stays a little 
bit on a button. This can be switched on and off here. Additionally short cuts can 
be displayed for the single buttons.  
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First steps 

Open cabinet 
A cabinet can be opened automatically or manually if WinClient was started. 
If WinClient is started connected to the server (Online mode) and a cabinet is 
opened, the settings of that cabinet are downloaded to the local cache. 

Open cabinet manually 
 

When clicking File→ Open → Cabinet a list of the available cabinets for the 
logged in user is displayed. Either double click on the cabinet to be opened or 
select the cabinet in that list and click to OK. 

Open cabinet automatically 
 

WinClient can open automatically the cabinet last used. This option must be 
active and can be set in menu Extras→ Options, tab General, Checkbox Open 
last used cabinet. 
 

Open document list 
When opening a cabinet the list of local documents is displayed automatically. If a 
document list is opened, the display can be refreshed in menu View by selecting 
Refresh. 

Search results 
 

The list of Search results is displayed after a successful search operation on the 
server has been performed. If the list was already open, it is automatically 
refreshed. The display can only appear if the client is connected to the 
FileDirector server. 
 
Hint: 
A setting on the server limits the maximum number of documents to be listed on a 
document list to 1000 entries. This default value can be changed by an 
administrator in file “web.config”.  
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See → Installation Guide 
 

Local Documents 
 

The list of local documents can be opened by selecting Local documents in 
menu File → Open. 

Personal folder 
 

The personal folder list can be opened by selecting Personal folder in menu File 
→ Open. 
 

Closing of document lists 
A document list can be closed in the upper right corner of the actual list displayed. 
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Searching in Cabinets 

General concerning searching 
 

A search operation for documents in a cabinet is performed after selecting tab 
Search of the control panel. The search operation can either be carried out in one 
document type only or over all document types of a cabinet. Another possibility is 
full text searching if the documents have been processed with OCR. The optional 
OCR module is necessary and the generation of a full text index must be 
configured on the server by an administrator.  
 
A comprehensive search over several cabinets is not intended. 

Clear index fields 
 

The actual display of index information in the index fields can be cleared before 
entering new search criteria by clicking to button Clear Index fields. 

Start search 
 

After entering search information into the fields start search by clicking to button 
Start Search (Ctrl-S). 
The following search option can be called (selected) by the drop down list. 

Start extended search 
 

You can search over all document types of a cabinet to which you have sufficient 
access rights. Start search by clicking button Start extended search. 
 

Info Search 
 

With Info search properties of a document can be retrieved, which are automatically 
saved as info with the document. The following properties are supported in the search 
algorithm: 
 
Created by 
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Created on 
Changed by 
Changed on 
Checked-out by  
Checked-out on 
Status 
 
When calling this option the relevant entry fields for these properties appear in the toolbox 
below the normal index fields of the selected document type.This option can be activated 
in Extras → Info Search. 
 
 

Start full text search 
 
Full text search over documents which have been OCR processed can be started 

by clicking button Full text Search . After entering of the relevant word the full 

text search is started after clicking button Search  next to the text field. 
 
In order to receive results in a full text search the OCR full text option must be 
licensed and configured on the server. Reading of full text information is executed 
by a scheduler, which starts in defined time intervals. Depending on this scheduler 
and the generation of the full text index in the SQL server the results of full text 
reading may for example only be available on the next day. 
 
Hint: 
a) In version 1.2.6 and later the content of the normal index fields is also written to the full 
text index. Therefore the contents of an index field can also be found by using full text 
search. 
 
b) In version 1.5.1 and later the content of the index fields are only written to the full text 
of the first page of a document.  
 
 

Search history 
 Previous Search  Next Search 

 
The search criteria entered during a session are stored in FileDirector. Therefore 
a user may browse through search operations already carried out in this session 
and reuse them. Select the relevant search information by browsing through the 
stored list with buttons Previous Search or Next Search. Watch for the entries in 
the index fields changing according to the list. Afterwards start the relevant search 

with clicking   for a specific document search in a document type, with clicking 

 as a comprehensive search, or as a full text search with  and  next to 
the text field. 
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Search parameter 
When searching with index fields a parameter can be selected for each field 
separately which specifies the search conditions. 
 

Parameter Description 
~ Allows wildcard search 
= Exact match 
> Greater than value specified 
>= Greater or equal value specified 
< Smaller than value specified 
<= Smaller or equal value specified 
=() Search for all documents with index field empty 
<>() Search for all documents with index field filled  
._. Search From - To  

Using this option two values have to be specified, a 
lower and an upper limitation for a range search. 

 
 

Searching using index fields 
 

To search with index fields in a cabinet select tab Search of the control panel. 
Specify the document type, enter search information and if necessary set the 
search parameter. 

Click button Search   for a search operation in the selected document type or 

button Extended Search  in order to perform a comprehensive search over 
all document types. 
The number of documents found and listed in the hitlist depends on the search 
criteria entered. If the user for example searches directly with a unique document 
number (e.g. invoice number), exactly one document should be found and 
displayed. 
 
If the search parameter is changed to Greater or equal, additionally all 
documents with numbers greater than the value specified should be listed. 
 

Search using OR combinations 
 
If several words are entered into an index field for search, the search performed in 
this index field is performed with a logical OR link between these words. 
 
Example: 
A document was filed under a name like “Grey”. If the user does not know how 
the index is spelled exactly, he can enter the several possibilities: 
 
Grey Gray Graye 
 
In this case the search is carried out for all single words entered; however they 
have to be stored at the beginning of the index field. 
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If a document was stored under “John Grey”, it would not be listed with this search 
operation. In this case the search operation can only be performed with a wildcard 
search: “*Grey”.  
 
Hint: 
When using an oracle database this function is not available. 
Normally only an asterisk * is attached 
 

Input assistance for index entry 
 
The search parameters which can be set in a drop down list in front of the index 
fields can be used as input assistance. Searching with wildcards like asterisk * is 
possible. 
 
Example:  
 
A search with „mi“ will not render  Smith as result, it will only render all documents 
beginning with „mi“.In order to have „Smith“as a hit, the search must be performed with 
„*mi“or „Smi“. 
 
The asterisk can be used in the middle of a word – e.g. when searching „Me*er“ all 
names including „Meyer“ and „Meier“ are listed.  
 
Hint:  
The asterisk * as a wildcard is only valid when SQL server 2000 is used as 
database backend. Using Oracle a % character must be used for wildcard search. 
 

Search in inverted commas 
 
To ensure that a search in WinClient or WebServer is always done with automatic 
inverted commas you can set the following entry in the web.config ("0" = off, "1" = on): 
 
    <add key="FDServer.SetQuotedIndexSearch" value="1" /> 
 
Hint: 
 
Please ask your administrator for configuration because this is a general setting on the 
server. 
 
 

MRU-Lists 
With the MRU-Lists (most-recently-used) the entries are listed which were already 
entered before.So it’s possible to repeat the entries without typing in again the word. With 
the keyboard this list can be opened with ALT . With the mouse you can drop down the 
list with the arrow at the right side of the indexfield. 
 
Clear MRU list 
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The MRU list keeps up to 32 entries. As soon as the list is full the last entries will be 
overwritten automatically. If you want to delete MRU-lists, you must click on Extras → 
Options → Clear MRU-List. 

Keyword lists 
If keyword lists were specified for certain index fields, the valid entries can be 
selected directly. Using keyboard this list can be opened by ALT . 
Shortcuts can be used for keyword list entries which avoid typing of complete 
keyword values and accelerate keyboard entry. 
In Version 1.2.3 and later several keywords can be selected simultaneously by 
checking them in a drop down list. They are entered into the index fields 
separated by semi colons.  
 

   
The control box displays fields which are connected to keyword lists with this symbol.  
 
Hint: 
If keyword lists are configured so that manual entries are possible, these manually 
entered keywords are held in the local cache of the relevant user.  
 

Usage of shortcuts in Keyword lists 

 
In order to be able to select the words windows conformal and using the shortcuts 
anyway you must use a semicolon behind your input if the entries are not unique. 
 
Example: 
In the wordlist are names listed like e.g. „Michael Eskamp” (Shortcut ME) and “Maria 
Immenfeld” (Shortcut MI). If “MI” is entered the name “Michael” will appear, because the 
first two letters are searched windows conform. If the shortcut is entered with semicolon 
“MI;” the entry “Maria Immenfeld” will be found. 
 

Date entry 
If a date should be entered, a diary opens up near to index field, where the 
relevant date can be selected with the mouse. 

 
The control box displays fields which contain dates with this symbol. 

Memo fields 

 
If a field is configured as a memo field, this symbol is displayed next to the index field. A 
field of type memo allows nearly unlimited characters to be entered. 

ODBC database links * 
Using ODBC links index fields can automatically be filled if a unique index value is 
specified in a certain index field.  
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If for example a client number is entered, the relevant address information can 
automatically be added from a connected database to the index in Edit mode. 
The connection of index fields to a database must be configured as an ODBC 
connection on the server by an administrator user. 

Manual indexing using OCR zone recognition 
If OCR zone recognition is licensed on the server, it can be used as an assisting 
tool for manual indexing. The manual OCR zone recognition must be installed as 
an additional plug-in. 
See section → Point and Shoot in plug-ins. 
 
 

Full text search  
 
The content of documents can be searched in order to retrieve a document which 
contains certain words or phrases. This can only be achieved, if the documents 
were processed with the optional FileDirector OCR module. The OCR full text 
module can be configured to process only selected document types. Depending 
on the configuration the full text information is only available for retrieval after a 
scheduled process has added the full text information to the database. 
 
To do full text retrieval, select tab Search of the control panel. Select the 
document type and activate the text field which is used to enter search information 

by clicking to Full text search . To start full text search enter the word(s) and 

click to button Search  next to the text field. 
 
 

Searching multiple words in full text using AND, OR, OR NOT 
When you search multiple words in a full text, you can connect the entries in the search 
field.  

AND - function: 
When entering „Robert AND Mueller“ in the search field of a full text, all pages are found 
containing BOTH terms.  

OR function: 
For example invoices or credits are archived in a document type. When searching 
“invoice OR credit”, all pages are found – either containing the word invoice OR credit.  

OR NOT function: 
When looking up e.g. „invoice OR NOT Mueller“, all invoices are listet NOT containing the 
name Mueller.  
 

Full text search combined with index fields 
When a full text is searched for a term, you can search in combination with index fields in 
version 1.5.1 or later. If you fill out the index fields additionally to the full text search, you 
will limit the result of the search. 
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Hint: 
When you perform a search for a term in the full text which is also to be found in one of 
the index fields, it might happen that a page will be displayed that does not include the 
term in the text on the displayed page. The reason is that index data will be additionally 
written to the full text.Thereby it is possible to find documents via index terms additionally 
via the full text. 

Document lists 

Types of document lists 
The three different document lists in WinClient serve different purposes and allow 
processing of documents in different ways depending of the document list used. 
A document may appear simultaneously on different lists, for example as a server 
document or as a local copy on the local document list. 
 

Search results 
After a successful search operation the results are displayed on the search list. 
If this list is already open, it is updated with the relevant results. This list can only 
be displayed, if a connection is established to the Filedirector server. 
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If the search was performed in one document type, only documents stored in this 
particular document type are listed. If the search was performed over all 
document types assigned to the relevant user, the search result is listed 
separately for each document type as displayed above. The name of the 
document type and the number of documents found is displayed. 
For each document the document status is displayed giving you a quick overview, 
which documents are available and which documents have been checked out by 
other users or yourself. 
 
The document list can be sorted within each document type by clicking the 
relevant column header. Documents are displayed by double clicking to the 
relevant hitlist line.  
 

Local documents 
 

The local document list is opened by clicking button  in the toolbar or by 
selecting entry Open in menu File. The documents displayed in this list are stored 
locally on the computer.  
 
Only documents are displayed on the local list, which are displayed by the actual 
user, which was checked out by him, which were downloaded or created new. 
 
 

 

 
 
New documents either scanned, imported or sent to FileDirector, are stored and 
displayed in the local document list before they are checked in to the FileDirector 
server. 
 
Accordingly documents which were checked out and documents, from which a 
local copy was created are displayed in the local document list. 
For each document the document status is displayed giving you a quick overview, 
which documents are available and which documents have been checked out by 
other users or yourself. 
The document list can be sorted within each document type by clicking the 
relevant column header. 
Documents are displayed by double clicking to the relevant hitlist line. 
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The arrow displayed in the column header additionally allows specifying display 
filters. (All, custom, blanks, no blanks, archived). With setting Custom a list can 
be sorted so that entries greater equal and smaller equal are filtered out. 
 
See → Set filter for document display 
 

Personal list 
The local document list is opened by clicking button  in the toolbar or by 
selecting entry Open in menu File. The documents displayed in this list are sent 
to you by other FileDirector users or are sent automatically by processes if you 
were specified as a recipient in a process designed in module process 
management.  
 

 
If documents should be received from other users or by processes WinClient must 
be connected to the FileDirector server. 
 
 
For each document the document status is displayed giving you a quick overview, 
which documents are available and which documents have been checked out by 
other users or yourself. 
 
For each document of the list an action can be specified by process management. 
This can be a task like Approve/Reject, Comment or View. This task must be 
carried out by the relevant user in order to move a document to the next process 
step. 
 
Documents are displayed by double clicking to the relevant hitlist line. 
 
If a document is received, the personal list must be refreshed. In Extras → 
Options → Notification an automatically notification can be specified if a new 
document arrives on the personal list. When pressing F5 the refreshing is 
performed manually. 
 
Hint: 
Please note, that during the specified scheduled intervals a contact is established 
to the server and the client license is not returned as long as WinClient runs. 
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Document status 
Each document on a document list has a defined status. The status shows if a 
document is stored locally on a computer or on the FileDirector server. If a 
document is edited by another user, it is displayed with status “read only” and 
cannot be edited at that time.  

Status New  
Documents with status New  are stored locally on the computer and have not 
yet been checked in to the FileDirector server. They are only available for this 
special user on this computer and appear on the local document list. 

Status Archived   
Status Archived denotes that a document was checked in to the FileDirector 
server. In order to be edited or changed a document has to be checked out to 
prevent other users from changing it simultaneously. Depending on configuration 
this can be done manually or automatically. Documents of this status can appear 
on all three lists. 
A document of status Archived is downloaded from the server if it is displayed on 
the search list. If an archived document appears on the local list, it is a local copy 
downloaded to the PC. They are also still displayed on the local list after checking 
in if a local copy is maintained. That way documents can also be displayed 
without connection to the server. 
   
 
See also → General settings/Options 

Status Checked out  
A document is displayed as Checked Out , if it was checked out from the 
FileDirector server by the user himself. During this process automatically a copy 
of the document is created and displayed on the local document list. This status is 
displayed for each checked out documents listed in your personal list. For other 
users these documents are displayed with status Read only and can not be 
edited. 

Status Read only  
Documents displayed with status Read only are currently checked out from 
another FileDirector user. These documents can be displayed but cannot be 
checked out in order to be changed. This status can appear in all three document 
lists.  
 
Hint: 
In urgent cases (for example: checked out documents are stored on a hard disk 
which is damaged) this status can be reset by an administrator by clicking Undo 
Check-out. 
ATTENTION: Check-In of previously checked out documents is not possible 
anymore! They must be deleted from the local list and must be checked out again 
for editing. 
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Send  
Status Sending is displayed for all documents currently being sent to the 
FileDirector server. These are either new documents being checked in for the first 
time or previously checked-out documents which are checked in again after 
editing was finished. This status can appear in all three document lists. 
 

Deleted 
The deleted documents from the server can be shown with the status , by switching on 
the info search in Extras → Options → Info Search and selecting the entry “deleted” in the 
field “status”. If you run a search now, the deleted documents are shown and they can be 

undeleted with the right mouse context menu command  

Status 
In the field „status” on the local document list appears e.g. hints for checkin errors. 
These hints can be false entered mandatory fields or a field that should be checked of 
validity by the server (e.g. if a valid date is used).  
 
 
Hint: 
The behaviour during Check-In and Check-Out strongly depends on various 
settings. Under Extras → Options → General different automatic actions can be 
configured. See section:    Check In and Check Out 
 

Display modes of document lists 

Handling of document types lists 

Standard view 
Each document list shows the documents grouped by document types and all 
document type groups are in dropped down mode. The number of document 
types is displayed at the top of the list. 
If an extended search is performed, all document types are listed. 

Switch to detailed display 

With button Toggle detail view  the display is toggled between detailed view 
and list view of the document types. 

Drop down document list 
To drop down a document type list, click to button , which is located left to the 
document type name. 

Minimise document type list 
To minimize a document type in a document list, click to button , which is located 
left to the document type name. 
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Display only one document type 

To display only one document type in the list click to symbol  left to the column 
headers of the document type. 

Display all document types 

To display all document types in the list click to symbol  left to the column 
headers of the document type. 

Handling of lists for document display 

Sort ascending/descending inside of a document type 
The documents in a list of document types can be sorted by any column. Click to 
the relevant column. Another click to this column header toggles the sort order. 
Alternatively Sort ascending  or Sort descending   can be selected in the 
context menu which opens when right clicking to the column header.  
 
After a performed search the result can be re-sorted via the column sorting by holding the 
Shift-Key. 

Changing the column order 
The sequence of the columns of a document type can be changed by drag and drop of 
the column header to the new position. 

Changing the column width 
The width of a column displayed in a document type can be changed. 
 
Method 1: 
 
Move the mouse cursor to the dividing line between the column headers, the 
mouse cursor will then change to a double headed arrow. By holding down the left 
mouse button the dividing line can now be moved. 
 
Method 2: 
 
Move mouse cursor to the column header of the column to be changed, open the 
context menu by right click and select   Best fit, which automatically fits the 
width of that column. When selecting Best fit (All columns) all columns of that 
document type are automatically adjusted. 
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Fit columns during run-time 
 

 
 
If a document type uses a great number of columns, they may de unreadable 
because they are to narrow depending on monitor size and resolution. It is 
possible to select only certain columns for display and make others temporarily 
invisible. Use Runtime Column Customization in context menu of the column 
header. A small window appears into which columns can be dropped by a drag 
and drop operation. They are not displayed anymore. In order to display all 
columns again, minimize the list and afterwards change to detailed view. 
 

Open list 
To open a group of columns for document display click to , which is located left 
to the document type name. 

Minimize list 
To close a group of columns in order to hide document display click to , which is 
located left to the document type name. 
 

Set filter for resulting list 
 

For each column a drop down arrow is displayed. Filters can be defined for the 
index listed in this column. The list can be filtered for blanks, non blanks or entries 
already archived.  
 
Additionally custom specific filters can be configured which can filter the index 
values of a column for certain ranges: 
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Arrange Tabs / Display lists side by side 
 

 
 
In order to display document list more clearly, tab groups can be defined. As soon 
as two tabs are displayed for the document lists (for example search list and local 
list), a tab group can be created in context menu (right mouse click). Select in 
context menu New horizontal tab group or New vertical tab group. A new area 
appears with the document list marked before. The lists can be moved by drag 
and drop from one group to the other or with the context menu with Move to 
previous/next tab group. 
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View documents side by side 
 

 
 
By arrangement of different tab groups several documents can be displayed side 
by side for comparison. When opening the context menu of the document display 
(right mouse button) a second display window can be opened by Duplicate 
display. If the display is duplicated in a different tab group, documents can be 
displayed side by side. 
 
Method: 
 
Retrieve a document from a list and display it. 
 
Click to Duplicate display in context menu (right mouse button) 
Now retrieve a different document and display it in the second display window. 
Select the tab in the document display and create a second tab group for the 
image display window. 
Now the different documents can be viewed and compared in different document 
display windows. 
 
 

Display of documents  
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About documents  
A document in FileDirector is either a one page or a multipage document. 
Additionally to the pages index data are stored to a document, which are listed in 
the document list. One page can either be represented by a scanned page or by a 
file in its original file format like for example MS Word or Excel (Edocs). 
 
FileDirector WinClient has very flexible display utilities. If installed alone, it is able 
to display TIFF and JPEG files, the formats used to store black/white, greyscale 
and colour documents. 
 
If FileDirector Component Service is installed, WinClient is able to display more 
than 200 different file formats including all Microsoft Office formats and several 
CAD drawing formats (electronic documents/Edocs). 
One document can contain different formats, for example a scanned page and a 
Word document. 
If Component Service is installed and you want to display a page, you can retrieve 
the document and browse through it. 
Each electronic document is displayed in FileDirector as one page of a document, 
even if it contains many pages within itself. 
 
If Component Services are not installed, these files are displayed as icons and the 
relevant application must be installed in order to display them. 

Display options 
The display window has three settings. You can display the current page together 
with the thumbnails (default setting). The display mode can be switched to display 
only the thumbnails for fast document overview or to display only the current page 
without the thumbnails. 
The display window can be moved and resized to the proper size. 
 

Display thumbnails and image 

Select  from the toolbar Display in order to display the thumbnails alongside 
the current page. 

Display only thumbnails 

Select  from the toolbar Display in order to display only the thumbnails 
overview in the display window. 

Display only image 

Select  from the toolbar Display in order to display only the current page in he 
display window.  

Toggle between thumbnail view and page display 
You can toggle display mode between Page with thumbnails and Page only by 
a double click on the display window. 
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Thumbnail view 

Scroll with mouse wheel 
If you use a wheel mouse you can scroll with this wheel through the thumbnails.  

Selection of single pages  
If only certain pages of a document should be selected, this is done in the 
thumbnail view. Several pages of a document can be selected for example for 
printing and sending by Email. 

Select document for display/navigate 
If a document list is displayed, it is displayed by a double click on the relevant line 
of this list. The display window opens and displays the relevant document. 
With the following commands of the display toolbar navigation through the 
documents is performed: 
  

 Display first document of document type 

 Display last document of document type 

 Display previous document of document type 

 Display next document of document type 

 Display first document of previous document type 

 Display first document of next document type 

 

Select page of document for display 
 

If the first document is opened, automatically the first page of this document is 
displayed together with the thumbnail view. 
You can browse through the pages (also with mouse wheel) or select the relevant 
page in the thumbnails or use the buttons in toolbar Browse through 
documents. 
 

Entering of page number 
You can enter the relevant page number directly by keyboard into the page 
number box in the toolbar Browse through documents. 

Select page in thumbnail view 
If the thumbnails are displayed together with the current page click on the relevant 
page in order to display it. 
If only thumbnails are displayed double click on the relevant page in order to 
display it. 
 
In order to browse through the pages of a document the following buttons from 
toolbar Browse through pages: 
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Display first page of a document 

 Display last page of a document 

 Display previous page of a document 

 Display next page of a document 
 

Tools for page display 
 

The display of a document within the image display window can be changed and 
arranged for example by zoom and rotation. 
Some or all of the display tools may not be available when displaying electronic 
documents. 

Display whole page in the image display window 

Select  from toolbar Display in order to fit the displayed page into the image 
display window. 
This is also possible in the context menu which opens up by a right click on the 
image display window. 

Fit width of page to he document display window 

Select  from toolbar Display in order to fit the width of the displayed page to 
the image display window. 
This is also possible in context menu which opens up by a right click on the image 
display window. 

Display page in original size 

Select  from toolbar Display in order to display an image with maximum zoom. 
When displaying TIF or JPEG files, each pixel of the image is displayed as one 
screen pixel. 
This is also possible in context menu which opens up by a right click on the image 
display window. 

Zoom in 

Select  from toolbar Display to increase the zoom factor in order to increase 
the displayed image. 

Zoom out 

Select  from toolbar Display in order decrease the zoom factor in order to 
decrease the displayed image. 

Display selected part of an image 
You can display a part of an image by dragging a rectangular box around the 
relevant part with left mouse button. 

Rotate page 90° counter clockwise 

Select  from toolbar Display in order to rotate the displayed page 90° count 
clockwise based on the current view.  
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This is also possible in context menu which opens up by a right click on the image 
display window. 

Rotate page 90° counter clockwise 

Select  from toolbar Display in order to rotate the displayed page 90° 
clockwise based on the current view. 
This is also possible in context menu which opens up by a right click on the image 
display window. 

Rotate page 180° 
Select  from toolbar Display in order to rotate the displayed page 180° based 
on the current view. 
This is also possible in context menu which opens up by a right click on the image 
display window. 
 
Hint: 
Pages of archived documents can be rotated temporarily without checking out this 
document. Therefore users which are only allowed to retrieve documents and not 
to edit are allowed to rotate a document for proper display. 
 
A rotation is only stored and displayed during next retrieval of the relevant 
document, if it is checked out, rotated and again checked in. Only this way 
rotations are stored. 
 

Maximize document viewing area 

 With this option the page can be displayed in fullscreen mode. You can switch fast 
between the different views for better reading the text of the documents with the key F12. 
 

 

Selecting documents 
Among the general selecting procedures you can use different commands from the right 
mouse menu. To choose all documents you use the shortcut  Ctrl +A or  
 

 Select All from the context menu  

 Toggle or Strg +T to invert the selection of chosen documents 

 Remove or Strg +R erase the selection of documents. 
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Check In and Check Out 

Why check in or check out documents 
New documents are stored locally on the workstation on the local document list. 
They are not available for other users until they have been checked in on the 
FileDirector server into the relevant cabinet. Afterwards the document is stored in 
the cabinet and is available retrieval. If you want to edit a document which is 
stored in a cabinet you have to check it out first. 
 
Only then it is possible to change a document and the system ensures, that 
nobody can change it while it is checked out. But a checked out document can be 
retrieved, the system will show the unchanged version in read-only mode. Each 
change of a document is only stored in the cabinet and available for the other 
users, if the document was checked in again after the changes. 
 

 

Check In documents 
Documents with status New are stored locally on the work station and are not 
stored in the FileDirector cabinet. They are listed on the local document list. 
Documents with status Checked Out are always displayed on the local document 
list and eventually also on the Search list depending on the search criteria used. 
 
The documents may also appear in the personal list if they were sent from 
another FileDirector user or by process management. 

Select Check In  in order to check in the selected new or changed documents 
into the FileDirector cabinet. 
This can be done by a button in toolbar Browse through documents or in context 
menu (right mouse button) if the document to be checked in is selected in the 
document list. 
 
When checking in, the document is sent to the server where it is available for 
retrieval. 

Automatic check in / Setting in Options 
 

Documents can automatically be checked in after editing index data. This can be 
specified for new documents or checked out documents. 
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The automatic check in can be set via menu Extras → Options in tab General. 
The following options have influence on the check in of documents: 
 

Delete new documents after check in 
A new document is stored on the local document list of the user. When this option 
is set, the document is automatically deleted from the local list when the 
document is checked in. If this option is not set, the document remains on the 
local list with status “Archived” and must afterwards be deleted manually.  

Delete revised documents after check in 
An already archived document which was checked out appears on the local list of 
the user. When this option is set, a document with status “checked out” is deleted 
from the local list when being checked in again. If this option is not set, the 
document remains on the local list with status “Archived” and must afterwards be 
deleted manually. 

Do not remove from list 
A document list is displayed after a search operation. If a document from this list 
is edited, it is checked out and checked in again. This setting decides, if a 
document is removed from the previous search list after check in or not. 

Auto. Check in of new documents 
With this option set new documents are automatically checked in directly after 
scanning. If this option is used, the index should be entered before scanning in 
order to check in the document with correct index information. If documents are 
automatically checked in without index a revision is created automatically when 
the index is specified afterwards (not in a document type specified as mail box). 

Auto. Check in of new documents after index edit 
If this option is set, new documents are not checked in immediately but after index 
editing. With this option a short control or amending of index information is 
possible, before checking in. 

Auto. Check in of archived documents after index edit 
If documents are already archived on the FileDirector server it may be annoying to 
check out documents manually for editing and afterwards check in. It may useful 
and speed up working if check in and check out is done automatically when 
editing. 

Remind to check in new documents after program end 
If new documents are not checked in, they cannot be retrieved on the server. If 
retrieval should be possible the user must not forget to check in the new 
documents. When this option is set the user is reminded to check in the new 
documents when WinClient is closed. 

Remind to check in documents after program end 
With this option set the user is reminded to check in documents which are 
checked out when WinClient is closed. 
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Hint: 
Please note that the automatic functions always need a connection to the server. 
If WinClient is used in Offline mode, no check in or check out can be performed. 
 
See also: General settings / Options 
 

Mandatory fields and test during check in 
 

 
 
If mandatory fields were specified, the index must match the field properties 
before the document can be checked in. There are several types of mandatory 
fields: 
 
Field must be filled completely, empty not allowed or valid date must be specified. 
If a document is not checked in because of a mandatory field, an appropriate hint 
about incorrect index appears in field „Upload status“. 
 

Protected fields 
 
There are protected fields which are greyed out and inactive in WinClient or fields 
which are greyed out after a document has been checked in. Protected fields 
cannot be changed. A date field with automatic date for example can always be 
protected. A manual entry of index can be protected after check in so that the 
index cannot be changed afterwards. The configuration of protected fields is done 
by an administrator user. 
 

Cancel Check in of several documents 

 
 
Several documents can be selected and checked in simultaneously. The status 
bar at the bottom of the WinClient window displays status information. The left 
progress bar shows the progress over all documents to be checked in. The right 
progress bar shows the progress of the current document. A Stop button is 
located between the progress bars which Stops check in process. This button is 
useful if check in of a very large document takes too long and should be stopped.  
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Check out documents 
Documents with status Archived can be checked out from a FileDirector cabinet. 
If a document is checked out a copy is stored on the local document list of the 
work station and displayed on the Local document list. During the time a 
document is checked out it is displayed with status Read only for all other users. 
A different user can only check out this document after it has been checked in 
again. 

Select Check out  from the toolbar or click with right mouse button on the 
document list in order to check out the selected documents. 
 

Undo Check out 
With option Undo Check out it is possible to rechange the status of a document 
from Checked out to Archived. The document is then on the same version 
before it was checked out. Changes which have been introduced during check out 
status are not stored. 
 

Select Undo Check Out  from the toolbar in order to reset Check out for the 
selected documents. 
This command can only be performed by an administrator or by the user who has 
previously checked out the document. 
 
Hint: 
In urgent cases checked out documents (for example if they are stored on a 
damaged hard disk) with status “Read only” can be checked in again with “Undo 
Check out” by an administrator user.  
ATTENTION: In this case checking in of documents previously checked out is not 
possible anymore. They have to be deleted from the local list and checked out 
again if they should be changed. 
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Revisions 
 
All changes on documents in FileDirector are stored as revisions. It is not possible 
to perform a change of a document without storing of these changes as revisions. 
 

 

Display Revisions 
The displaying of revisions is protected and must be granted as a right. To display 
the revisions click to tab Revisions. This tab only appears if revisions are stored to 
the local documents. The tab appears in the thumbnail part of the display window. 
With the drop down list you can select and display the different revision in order to 
recall the document changes. Changing of the document index is also stored as a 
revision. 
 

Change Revision/ Check out 
Only the last revision can be checked out and changed. A warning is displayed if 
the user tries to check out an earlier revision. This is also valid for electronic 
documents (Edocs). 

Delete revision 
Revision cannot be deleted. 

Print Revisions 
Select the relevant revision. In order to print single pages, select the pages to be 
printed in the thumbnail display and select the “Print” command either in the main 
menu or in the context menu of right mouse button.  
To print the current page select the current pin the document display and select 
the Print command there. What is being printed always depends on the current 
selection. 
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Document type without revisions (mail box) 
If a document type is set up as a mail box from administrator, it does not create 
revisions. If a document should have changes that should be recalled later, it must 
first be moved to a normal target document type. 

How is a revision stored? 
In revisions of scanned pages, which are stored as *.tif or *.jpg files only the 
changes but not the complete document is stored again. If pages are appended 
they are stored as additional *.tif or *.jpg files. 
 
When electronic documents (see Edocs) are changed they are stored as a 
complete copy because the changes are done by another application (for example 
Word). 

 

Editing of documents 

Editing - General 
 

 
Existing documents can be edited in many ways. It depends if it is an archived 
document in a cabinet or a new document on a local list. 
If a document may changed depends on the access rights of the relevant user. 
 
Scan options contain the appending and inserting of pages to existing documents, 
pages can be edited by adding annotations to the pages. 
Additionally index information of documents can be changed, whole documents or 
single pages of a document can be deleted, documents can be combined or 
documents can be split. 
 
 

Editing of document-index information 
 

Index information stored to a document can be appended or edited at any time. 
The relevant user must have the right to change documents. 
The editing of index is done in the control box which displays the index 
information for the current document. Only the index fields of the document type in 
which the document is stored are available for editing. 
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Each change of a document which was already checked in to a document type is 
stored as a revision after checking in again.  
 
Hint 
If a document type was configured by an administrator as a mail box, no revisions 
are created. This is a general property of a mail box. 
 
 

Editing of index data for a document 
 

Select the document to be edited in the document list. If the document was 
already archived you can display it after retrieving it. 
Select tab Edit in the control box. Select the document type. The index field 
relevant for the document type are displayed. Now new index can be entered into 
the fields or existing index can be changed. 

Click to. Execute changes  in order to carry out he changes. 
 

Moving of a document to a different document type 
 

To move a document into a different document type is done exactly as described 
before in editing of index. The only difference is that first the document has to be 
selected, then the target document type has to be set and the index fields are 

changed or filled. With Execute changes  the document is moved to the 
target document type with the index information specified. 

Editing of index for several documents 
 

Select the first document to be changed from a document list. If the documents 
are already archived a search operation hast to be performed first to list them. 
Select tab Edit in the control box. 
Enter new index information or change existing information in that document type. 
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Click to Execute changes  and go to the next document to change or add 
index. Do this by clicking to the next document of the list or use Execute changes 

and go to next document ; in this case the system automatically jumps to the 
next document on the list. 
 
 
During editing the listed values remain in the WinClient for the next document to be 
focues in the control bay, if the entry  
 

 <add key="PreserveFieldsOnEdit" value="true" /> 
 

is set in the file app.xml. If this setting is applied to the WinClient only, it will be 
overwritten with the next update. 
 
If this setting must remain after an update, it must be changed by an administrator on the 
server. This option for the rollout can be set in setups\WinClient\app.xml on the server for 
all following Clients installed on the server. 
 
 

Simultaneous changing of an index field for several documents 
In version 1.2.2 and later the content of an index field is displayed yellow in the control 
box when it is edited. This denotes, which index fields have been changed. In order to 
change the index of several documents simultaneously, select the documents to be 
changed edit the index field and click to Save changes. The changed index is now taken 
over for all selected documents.  

Indexing with keyboard 
If you want to index using keyboard only, you can jump from one index field to the 
next by hitting “Return”. If “Return” is entered when positioned in the last index 
field, the focus jumps to the button Execute changes and go to next document 

 another “Return” executes this button. In this case the focus immediately 
jumps to the next document of the list and does not have to be selected manually. 
 
Hint: 
Using Alt  keyword lists, date fields and previously used index can be displayed 
in a drop down list and used for fast manual indexing. 

Copy and move with drag & drop 

Move pages in one document 
To move pages in one document, the pages are selected in the thumbnail view 
and with (by) holding left mouse button moved to the target position.  
 
A blue line shows the target point where the page will be moved.  

Move pages from one document to another 
If one page must be moved from the current document in another document, select the 
pages in the thumbnail view and move them to the target document in the search list. 
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The pages are attached to the target document and can be moved to the final position in 
the document there. 
 

Copy a whole document in an other document 
A whole document can be copied by selecting it on the hitlist and move it with pressed left 
mouse button onto another document. 
The original archived document remains unaffected because of the auditing acceptability 
and if necessary it can be deleted. 
   

Copying selected pages 
If pressing the CTRL-Key while scrolling, the selected pages are copied. Pages can be 
scrolled inside a document and also from one document to another.  
 

Creating a link to a document in a Windows-directory 
Moving documents via drag & drop from a windows directory to a page, a link to this path 
is created.  
 
Hint: 
Please keep in mind that the link remains on the page even if the file does not exist any 
longer in the specified path.  
 

Indexing with predefined OCR forms 
 

  
 
If a document shall be indexed automatically, there must be predefined forms with OCR 
zones in the Enterprise Manager. From these zones the content will be read and written 
into the index fields. 
In the normal case the OCR mode is deposited to a scan profile to run the OCR 
recognition during the scanning process. 
  
If a form is configured after the documents were scanned, it is possible to run the OCR 
recognition by selecting the documents in the WinClient and start the OCR recognition 
with (by selecting) Edit → OCR Document on existing documents. 
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Use Scanprofile Configuration  
With this option the settings are used which are configured in the scanprofile the 
document is scanned with. 

Full form recognition 
With this setting all forms are checked for identifier, which are activated in the Enterprise 
Manager and the documents are identified and sorted and indexed to the target 
document types. 

Document type limited form recognition  
If there are several documents defined for one document type, only these forms will be 
used for recognition. If the documents are sorted before scanning, you will have a faster 
and better recognition. 

No form recognition - Always use this form 
If „No form recognition“ is selected, a special document can be chosen, which is used for 
the recognition. Is an identifier configured, the recognition for separating sheets pages 
can be used during the batch scan. 

Add columns 
By pressing the right mouse button a context menu opens where you can add columns 
for checking sums. Select the documents which contain a numeric value in a column 
which is to add and call the command with the context menu over the column. Now the 
result of the addition is shown in a separate window. 

Automatic check in of documents 
If index data have to be stored to archived documents the document has to be 
checked out and afterwards checked in to save the new information to the 
cabinet. This process can be enhanced and made more efficient if in menu Extras 
-> Options under tab General the check box Auto. Check in of archived 
documents after index edit is set. The editing action is finished after the 
document has been checked in again and its status has again changed to 
Archived. 
 
If the document has status New, it can be automatically being checked in if in 
menu Extras -> Options under tab General the check box Auto. Check in of 
new documents after index edit is set. The status will automatically change to 
Archived if the automatic check in option was selected. 
See also → Check in documents 
 

Combine documents 
With Combine documents   in tab Edit several documents can be combined 
to a single new document. It is also possible to append one or more documents to 
a specified document. This depends on the status of the documents to be 
combined. 

Combining of archived documents 
Select the documents to be combined. The selected documents are appended to 
the document selected as the last one. 
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If documents with status Archived are combined, the appended original 
documents are not deleted, because it must be possible to recover the history of 
the documents. If these documents should be deleted this must be carried out as 
an extra action. 
 

Combining of new documents 
If documents with status New are combined, the appended documents can be 
deleted afterwards because it was not archived on the server. 

Combining of new and archived documents 
If documents with status New and status Archived should be combined, the 
archived document must be retrieved and checked out first. After check out it is 
stored on the local document list. Now the documents to be combined can be 
selected. They are appended to the document selected last.  If the appended 
document has status New, it is deleted from the local list. In the other case, if the 
archived document is appended to the new document, the archived document 
stays on the server. After the documents have been combined they must be 
checked in again. 
 

Splitting of documents 
 

Command Split documents allows to split a document into two parts. In 
thumbnail display the split position can be specified, the splitting is done right from 
the selected page. All pages which follow the currently displayed page form a new 
document with identical index information. 
 
Splitting of a document: 
Select tab Edit in the control box. 
Display the document to be split in thumbnail view. 
 
Select the page, which should be the last page in the original document – all 
following pages are sent into a new document. 

Select Split documents  from the tools in tab Edit of the control box. 
 
If the document to be split has status Archived the status is changed into 
Checked out and the part cut off is listed as a new document in the local 
document list. 
 
In order to retrieve those documents they have to be checked in again (if 
necessary after index change). 
 

Duplicating of a document 
 
Select a document in the list and select from the context menu (right mouse 
button) the command Duplicate. If a document is duplicated it appears on the 
local list with the same index as the original document with status New. The index 
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data can be changed on the local list before checking in of the duplicated 
document. 
Please note that data can be redundant, changes in the original document are not 
carried out on the duplicated document. 
 
 

Convert a document 
By using this option you can convert a scanned page automatically to an editable Word-
document. The page will be scanned via OCR and saved as a .doc file. It is necessary 
that the OCR is installed on the client to use this function and a client OCR licence is 
required. 
 
Hint: 
As the conversion is done by the OCR text recognition it might be necessary to rework 
the text depending on the quality of the source. 
 
 

Link to a document 
 

If the same document should be retrieved with different index data, it would not be 
useful to create a copy or by duplicating, because when the document has to be 
changed the copies would remain unchanged. Data would be stored with high 
redundancy and overview and handling would be complicated. 
 
Therefore it is possible to create links to documents. The link uses the same 
original document but the index may be different. If a change is made in a link, 
which also affects the original document the link and the original document are 
checked out automatically. Such a change would be an annotation or an 
appended page.  
If only index data of a link are changed, the original document remains archived. 
 
Hint: 
In context menu in Info the ID of a document is displayed. The ID is a long unique 
string of characters. If a link is created, the link document receives the ID from the 
original document as ID (Ref). In the original document the ID (Ref) is the same 
as the ID. The ID (Ref) denotes the linked document.  
If an original document displays an ID (Ref, there are links to this document. If a 
link has an ID (Ref), this is the original document to this link. 
 
Important hint:  
This option is not available in version 1.2.3 or later.  
 

 

Creation of an empty document 
 

Select New document  from the Scan tools in the control box in order to 
create an empty document without pages. The document is created in the local 
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document list of the selected document type. This function allows empty 
documents to be created as “containers” for later scanning.  
 

Deleting of documents and pages 
 

 Delete 
Documents can be removed from a document list or the document itself is 
deleted. This depends on the status of the document and from the document list 
currently used. 

Delete single pages of a document 
Display the document by double click and select the page in display window. In 
thumbnail view you can also select several pages. The page can be deleted via 
the main menu or the context menu. 

Recovering of a deleted page 
If a page was deleted from an archived document and not checked in again, the 
version before deleting can be restored by clicking Undo Check out.  If the 
document as already checked in again, the page is present in the previous 
revision.  
 
A page deleted from a new document must be rescanned.  
 

Remove documents from a document list 
 

Local documents 
The local list contains new or downloaded documents. These can be deleted any 
time without affecting the server documents.  
Documents with status Checked out must be checked in again, before they can 
be removed from the local document list. If they are still listed as Archived on the 
local list after Check In depends on the automatic options during check in (→ see 
Options). If a document with status checked out cannot be checked in, check the 
status of the document on the server. If it is already checked in (by Undo Check 
Out), it can be deleted from the local list. 
 

Personal list/folder 
Document from the personal list can be deleted without deleting the relevant 
server document. If a document is stored on a personal list by a process of the 
process management module, it can only be deleted, after he process has 
terminated. 
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Delete documents from server 

Search list 
If a document with status Archived is deleted from the Search list, the server 
document is deleted, i.e. document is marked as deleted in the database. 
Documents with status Read only will disappear from the list, but they will appear 
again after a new search operation was performed which matches these 
documents. 
 

Select the documents to be deleted and select Delete  from the toolbar Edit, 
or use the context menu of right muse button. 
 

Reactivate deleted documents  
 
If a document is deleted in the WinClient, a flag will be set in the database, but it is not 
really deleted. With the Info Search a deleted document can be shown and displayed 
again. 
If the document shall be undeleted, it must be selected and with the context menu of right 

mouse click it can be reactivated with Undelete document. (???) 
 

 

Automatic Indexing (Forms recognition) 
 
Using text recognition index fields can be filled automatically by reading zones on 
the page. The forms recognition must be set up by an administrator. If pages to be 
scanned contain always the same structure a form with defined reading zones can 
recognized by the system.  
 
The following requirements are necessary for a zone recognition: 
 
OCR License 
Installed Component Services and OCR Engine on the client 
Stored forms with zone definitions 
One scan profile with OCR recognition activated 
Documents to be scanned with sufficient quality 
 
If OCR recognition is setup on the work station where WinClient is installed, the 
user can again perform an OCR recognition by clicking OCR Document  in 
menu Edit. This function is useful if for example documents should be indexed 
later or if “Use OCR/Forms recognition” was switched off in the relevant scan 
profile. 

 

Indexing from external applications (Codeless 
Connector) 
From external windows applications field contents can be taken over as index data with 
help of Codeless Connector. With a configurable keyboard shortcut the field content of 
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the external application is automatically transferred to the index fields linked in 
FileDirector. The connection of the fields and the shortcuts are configured in Enterprise 
Manager. See also section about Codeless Connector in Administration Guide (manual 
for FileDirector Enterprise Manager). 
 
Hint:  
The Codeless Connector can also be used with JAVA applications in Version 1.3 or later. 
For each work station using the Codeless Connector a licence is required. 
 

Security on document level 
 

If a user has full control on a document, he can access and specify security 
settings on a document. If for example a different user should edit a document 
which is normally not accessible for him, a user with full control can grant explicitly 
rights on that document for him.  
 
Vice versa:  
If a user should explicitly not view a document, but generally has the right to view 
it, this right can explicitly be denied. 
 
Open the document and select Extras → Security from the menu. 
A window for the specification of rights appears. Click to “Add” and add the user 
or group for which you want to give certain access rights. 
 
The following rights can be given: 
 
 
Full control  
Allows the user to grant rights.  
 
Create  
Is “Create” denied for a user he may create documents on the local list, but he is 
not allowed to check them in. This is only important for new documents. 
Appending or changes to existing documents is not denied if this option is denied. 
 
Delete  
If „Delete“ is denied, the user may not delete archived documents from the server. 
Local documents with status new may be deleted. Documents from the personal 
list may also be deleted if they are not currently sent by an active process. 
 
Modify 
Index may be changed, pages may be appended or annotations may be set. 
 
View  
Is the display denied generally the user cannot select the document during 
opening. 
 
Download  
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If „Download” is denied, a user can search for index data, but the according pages 
are not displayed with the document because the user is not allowed to download 
pages to the local cache. 
 
Hint: 
Using this option the management of the local cache and the log in to the computer is 
important. If standard authentication is used here, it may lead to lack of security if there 
work users with different rights on one work station. 
 → See Automatically log-in using current Windows account 
 
Downlod revisions 
If right „Download revisions“ is denied the user may only download the latest 
version of the document but is no allowed to call earlier revisions. 
 
Change annotations  
If annotations are set on a page, they cannot be changed if the user does not 
have this right. With annotations certain parts of a page can for example be 
hidden. 
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Annotations 

Annotations – General  
Annotations can be added to *.TIF or *.JPG pages of a document. Annotations 
can appear as highlighted areas displayed in colour, lines, arrows, hyper links etc. 
These annotations do not change the original document and are displayed on a 
layer above the original image. 
If annotations should be added to a page the document is treated as if it is edited. 
After adding annotations to a page a document can be checked in again to the 
cabinet creating a new revision. 
 
Changing of annotations is only allowed when the specific right is set. In this way 
for example text parts of pages ca be hidden by putting a white or black area 
above them which cannot be moved by certain other users. 
 
If a page has an annotation a symbol appears at the left corner in thumbnail view: 

 

Display/hide annotations 

Click to the button  Display/Hide annotation switches display of annotations 
on and off.  
Annotations can only be hidden or displayed by a user who is allowed to change 
annotations. 
 

Select annotation type  
In order to add an annotation to a page of a document it must be displayed in 
display window and the page must be stored in *.TIF or *.JPG format. 
The annotation type to be added to the page can be selected at two locations: 

Select from the list of Annotations  the relevant annotation type. The default 
icon for this is the area zoom icon like displayed above; this will change according 
to the annotation type selected. 
Display the page in the image display window and select   from the context 
menu of right mouse button. From the list of available annotations the type can be 
selected. 

Black area 
Select Black area  and drag a rectangular area on this page. It is filled with 
black.  
If this tool is selected, keep left mouse button pressed at the position where an 
edge of the rectangle should be located. Drag the mouse to the position of the 
edge on the other side of the rectangle and release the mouse button. 
 
You can change the colour within the rectangle by double clicking on the box, 
select Choose colour, select the colour needed and click to OK. 
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White area 
Select White area  and drag a rectangular area on the page. It will be filled with 
white. 
If this tool is selected, keep left mouse button pressed at the position where an 
edge of the rectangle should be located. Drag the mouse to the position of the 
edge o the other side of the rectangle and release the mouse button. 
You can change the colour within the rectangle by double clicking on the box, 
select Choose colour, select the colour needed and click to OK. 

Text  
Select Text , in order to add a text annotation to a page. A text annotation has 
no background colour. 
If this tool is selected, keep left mouse button pressed at the position where an 
edge of the rectangle should be located. Drag the mouse to the position of the 
edge on the other side of the rectangle and release the mouse button. 
The properties of this annotation type are displayed in a window. Enter the text 
and select font and colour. After clicking to OK the text annotation is displayed on 
the page. 
 
The text of a text annotation is recognized when full text reading is configured. A 
document can be found by typing text from a text annotation into the full text 
search. 

Line  
Select Line , to draw a line on a page. 
If this tool is selected, keep left mouse button pressed at the position where the 
line should start. Drag the mouse to the position where the line should end and 
release the mouse button. 
The colour of a line can be changed by double clicking to it. Select Choose 
colour, select the colour needed and click to OK. 

Arrow  
Select Arrow , in order to draw an arrow on the page.  
If this tool is selected, keep left mouse button pressed at the position where the 
arrow should start. Drag the mouse to the position where the arrow should end 
and release the mouse button. During dragging of the mouse the arrow is already 
displayed and the head of the arrow follows the mouse cursor. 
The colour of an arrow can be changed by double clicking to it. Select Choose 
colour, select the colour needed and click to OK. 
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Highlight 
Select Highlight , in order to emphasize a part of the image without hiding the 
content. This annotation works like a text marker used on paper. 
If this tool is selected, keep left mouse button pressed at the position where an 
edge of the rectangle should be located. Drag the mouse to the position of the 
edge on the other side of the rectangle and release the mouse button. The 
rectangle is already displayed during dragging with the mouse. 
The colour of the highlighted area can be changed by double clicking to it. Select 
Choose colour, select the colour needed and click to OK. 

Note 
Select Note , to add a note to the page. The note has a yellow background.  
If this tool is selected, keep left mouse button pressed at the position where the 
note should start. Drag the mouse to the position where the note should end and 
release the mouse button. The properties of this annotation type are displayed in 
a window. Enter the text and select font and font properties. After clicking to OK 
the note is displayed on the page. 

Hyperlink 
Select Hyperlink , in order to create a link to a URL on a page. 
If this annotation type is selected drag a window in the area where you want to 
place the hyperlink.  
 
After you have released the mouse button window is displayed where the 
properties of the hyperlink are specified. 
You have to specify a description of the hyperlink, which is used for display on the 
page. Select font and colour of the describing text. 
The hyperlink can be a link to a URL, for example an external website. Enter the 
web address in field URL. 
 

Signature 
To set a signature an image must be defined in Extras → Options → Signature → 
Choose your signature image. You can define up to three different signatures for one 
person. To set the signature there must be entered a password and for all three 
signatures the same password must be configured. The picture of the signature will be 
embedded in the tiff file of the document page and can not be deleted later. 

Stamp * 
Select Stamp , in order to add a stamp to a page. Follow the selection arrow to 
the right and select the relevant stamp.  
If this tool is selected the mouse cursor switches to a crosshair symbol with the 
selected stamp in the background. Move the stamp to the proper position on the 
page and drop it with a click to the left mouse button. 
 
Hint: 
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a) Stamps are only available when they are configured in Enterprise Manager by 
an administrator user. 
b) Stamps (for example with colour areas) are always translucent. 
c) Since version 1.4 stamps can be predefined in the scanprofile to put them 
automatically on the first page or on all pages of the document. 
d) “Embedding” stamps on a page e.g. the page is to be downloaded or sent via email, it 
is saved in *.jpg format.  
 
 

Annotation as hyperlink to another document 
Open the document to which the annotation should be placed. Search for the 
document to which the link to be added should point. Now you can pull the 
document by drag and drop on the displayed page. A link is created which is 
assembled from the index information of the document to be linked. 
Several documents can be selected and pulled simultaneously as links to the 
document. In this case the links are created one under the other on the page. 
If you click onto a link to view it, an additional tab will be shown to display the linked 
document. 
 
 
Hint:  
To delete a hyperlink click left to the hyperlink in order to select it. If it is displayed in red, 
it is selected and can be deleted. 

Move annotations 
To move an annotation, select it by pressing the left mouse button, drag it to the 
new position and release to mouse button the drop the annotation at the new 
position.  

Delete annotation 
To delete an annotation select the relevant annotation and use Delete  from 
the toolbar or use the context menu of the right mouse button. 
 
 

 

Print Documents 

Printing - General 
These printing options of FileDirector WinClient allow the printing of single or 
selected documents and the printing of single and selected pages of a document. 
You can print TIFF and JPEG formats with WinClient alone. If additionally Com-
ponent Service of FileDirector is installed, more than 200 different formats 
including Microsoft Office formats and Adobe PDF files can be printed. 
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Printing of a single document 
To print a single document click to the document you want to print on the 
document list. 
Select Print  from menu File or from context menu of right mouse button. 
 

Print several documents 

Print several selected documents from...to 
To print several documents which are listed one after the other on the document 
list, click to the first document of that range, hold the SHIFT key and click to the 
last document of that range in order to select them. 
Select Print  in menu File or from the context menu of right mouse button. 

Print selected documents  
In order to print several selected documents from a list, click to the first document 
to be selected press Ctrl key and select more documents to be printed. 
Select Print  in menu File or from the context menu of right mouse button. 
 

Print one page of a document 
Open the relevant document and display the page to be printed. Select the image 
display window and select Print  in menu File or from the context menu of right 
mouse button. 

Print several pages of a document 
You can select several pages of a document in thumbnail display for printing. 
Open the relevant document; display the pages either in Thumbnail view and 
image or Thumbnail View only. 
Hold Ctrl key pressed and click to the pages to be pressed in thumbnail view. 
Select Print  in menu File or from the context menu of right mouse button. 

Copy/print area 

 With this option an area of the page view can be selected. After opening the window 
a menu appears. Now you could choose wether to send the selected area to the printer, 
to send it exact scaled to the printer or copied it to the clipboard. From the clipboard it can 
be copied in the body of an email for example. 

Area with OCR text recognition into the clipboard 
In Version 1.5.1 or later is in the copy/print area menu the additional option „clipboard 
(Text)“ available. With this option the area of the scanned file is read by OCR and the 
recognized text is saved into the clipboard. The text can be copied from the clipboard into 
other applications.  
 
An OCR Server licence is required for this option. Thus it can be used by all WinClients 
which are connected to the server even without installing the OCR engine on each client. 
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Print document lists 
If a list of the selected documents should be printed they have to be selected first. 
Create a list with command Print document list from the context menu of right 
mouse button.  
 
Hint:  
For a search on the FileDirector server a maximum number of documents is 
specified to be displayed on a document list. This maximum value is as default set 
to „1000“. If more than 1000 documents should be printed and listed in WinClient 
this value can be set on the server by an administrator. 

Export and print list 
In order to export a list the entries to be exported must be selected. With File → 
Export → Export document list a file can be generated. This file can be saved 
as *.xml file or as *.html file. When generating a * .HTML file a table is generated 
which can directly be displayed and printed from Internet explorer. 
 
Hint:  
The hitlist can also be copied to the windows clipboard and then pasted into Excel 
or a text file for further working. 
 
 

Save document as file 
 

Save whole document 
Select the document to be saved in the search list and select „Save as..” in context menu 
of right mouse button. The pages of the document are saved in the directory specified 
during this process. 

Assign file name automatically 
If the whole document is stored, the content of an index field can be chosen as the file 
name. In this case the mouse cursor must be positioned on the index field to be used for 
file naming. Open context menu with right mouse button in this situation and select the 
“Save as…” command. If the mouse cursor points left to a document in the document list, 
the original TIFF file name is selected for saving. 

Save one page 
If you call „Save as …“ in display window, only the displayed page is saved with the 
original TIFF file name. 

Save a selection of pages 
Change to the thumbnail view in display window and select the pages to be stored. Open 
context menu with right mouse in this window area and store the pages in the relevant 
directory. 
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Save documents in different formats with/ without OCR text 
recognition 
Documents can be saved via the option „save as…“ in different formats. If you want to 
convert a scanned page into an editable text, you have to install the OCR engine on the 
local client. For this an OCR client licence is required. During the storage process the 
OCR recognition will be done automatically when using appropriate formats. 
 
  
The following formats can be used for saving: 
   - pdf (*.pdf),  
   - pdf mit Text (*.pdf)   
   -Word 2000, XP (*.doc)   
   -Word 97 (*.doc)  
   -Excel 2000, XP, 2003(*.xls)   
   -Excel 97 (*.xls)  
   -Text (*.txt)  
   -Text with line breaks (*.txt)  
   -Unicode Text (*.txt)  
   -Unicode Text with line breaks (*.txt) 
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Scanning documents 

Scanning - General 
 

 
WinClient of FileDirector allows the storage of pages to new documents or the 
appending to existing documents in several ways. Several scanners are 
supported without additional driver installation. Depending on the scanner black 
and white, greyscale or colour documents can be created. 
 

Supported scanners 
 

The support of a scanner depends on the available drivers. Different CANON 
drivers are integrated in the system. Other scanners can be used with TWAIN 
drivers delivered from the manufacturer with the scanner.  
 
WinClient supports directly without additional drivers many Canon Document Scanners 
for example DR-2050C, DR-2080C, DR-2580C, DR-3020,  
DR-3060, DR-3080C, DR-3080CII, DR-4010C, DR-5010C, DR-5020, DR-5080C, DR-
6080, DR-7080C, DR-7580, DR-9080C, MS 300, MS 350, CR-180 (cheque scanner) 
 
In order to use the scanners scan profiles are configured with Enterprise Manager 
which are used by the WinClient. WinClient can temporarily adjust the scan 
profiles. WinClient cannot create new scan profiles. 

Directory scan 
A scan profile can be configured as Directory scanner. In this case files are 
imported from a defined path, either a local path or a UNC path. This scan profile 
can be configured to delete the files after importing. 
 

Rights for scanning 
If a user should be able to scan documents he should have the scanning rights so 
that the tab Scan is available for him. If the user has no right to scan the tab will 
be invisible. 
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Scan profiles 
Documents are scanned with scan profiles. The scan profiles are configured in 
Enterprise Manager from a FileDirector administrator. Scan profiles should be 
designed to create maximum quality by setting the best scanner parameters for 
the documents to be scanned. In a scan profile a fixed document type can be 
designed or a field can be filled automatically. 
 
Which scanner settings can be set in the scan profile depends on the scanner and 
the driver used. In a scan profile the resolution is specified, if only the front or if 
the front and back of a page should be scanned, if black and white or colour 
should be used, the compression settings (for *.JPG files) and the page size.  
 
A scan profile can also be set to automatically collect a defined number of pages 
into one document. 
 
A scan profile can also be configured to be linked to one fixed document type or if 
the document type can be changed. 
 
Hint: 
If you cannot see the tab Scan, you might not have the right to scan.  
 

Change scanner settings 
 If you select a scan profile with a predefined scanner, the scanner settings 

can temporarily be changed in WinClient. For example the brightness setting can 
temporarily be adjusted to the quality of the documents to be scanned. The 
possible settings depend on the scanner driver used. 
 
If the configuration of the scanner driver is reseted with the “default” button to the default 
settings, the configuration of the Scanprofile will be assumed FileDirector version 1.3.1 or 
later. 

Set automatic value 
It can be specified, that an index field is always filled with a fixed value if this scan 
profile is used. One index value to be set automatically per scan profile can be 
specified by an administrator in Enterprise Manager. 
 

Use OCR-/Forms recognition 
This option can be switched on if forms are configured, if this was allowed in the 
scan profile. If documents should be scanned using OCR recognition, Component 
service and OCR engine must be installed on the Client PC. 
 
Hint: 
It is important for the OCR recognition, that index fields can only be recognized 
properly if documents are scanned with the same resolution than the stored 
sample page on which the form was designed. Therefore the resolution in a scan 
profile using forms recognition should predefined and not be changed by the user. 
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Selection of document types 
If a document type can  be selected during scanning or if it is fixed is predefined in 
the scan profile setup from an administrator.  
 
 

Scanning of documents 

Scan multipage documents 
All pages in the feeder of a scanner are scanned and stored in one document n 
FileDirector. The only exception can be set in the scan profile, if after a defined 
number of pages a new document should be created automatically. 
 
To scan a multipage document: 
Select tab Scan in the control box of the cabinet. 
Select the relevant scan profile. 
Select a document type where the document can be stored. When the scan profile 
is specified to not allow changes of settings, the document type is selected 
automatically. 
Index information can be entered into the index fields before scanning. 
Documents can also be indexed afterwards.  

Select  in toolbar Scan, if you want to empty the content of the index fields 
currently displayed. Additionally a scan profile can be designed to perform an 
automatic OCR/forms recognition on the whole document. In this case indexing is 
performed automatically – if forms recognition and the client are configured for 
this task. 
 

Select  from toolbar Scan in the control box in order to start batch scanning. 
 
See also → Show post scan options 
 

Scan single pages 
All documents in the feeder of a scanner are scanned and each page is stored as 
an own single page document in Filedirector.  
 
In order to scan a single page: 
Select tab Scan in the control box of the cabinet. 
Select the relevant Scan profile. 
Select a document type where the document can be stored. When the scan profile 
is specified to not allow changes of settings, the document type is selected 
automatically. 
Index information can be entered into the index fields before scanning. 
Documents can also be indexed afterwards. 

Select  in toolbar Scan, if you want to empty the content of the index fields 
currently displayed. 
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Additionally a scan profile can be designed to perform an automatic OCR/forms 
recognition on the whole document (Use forms recognition). In this case indexing 
is performed automatically – if forms recognition and the client are configured for 
this task. 

Select  from the toolbar Scan in the control box in order to start scanning. 
 

Append pages  
Pages can be appended to any document in FileDirector apart from documents 
which have status Read only. These documents are currently checked out for 
editing by another user and can only be edited by somebody else after they have 
been checked in. 
If the document to which pages should be appended displays status Archived it 
will have status Checked out after scanning. The document is then displayed on 
the local document list. 
The scanned pages are appended to the end of the document. 
To append pages to a document select tab Scan in the control box of the cabinet. 
Select the relevant Scan profile. 
Select the document to which pages should be appended. With Append pages 

 from toolbar Scan the pages can be appended by scanning. 
 

Insert pages 
To insert pages into a document select tab Scan in the control box of the cabinet. 
Select the relevant Scan profile, select the document into which you want to 
insert and open it. 
Select the page for inserting. The new pages will be inserted before the page 
selected. 
 

With Insert pages  from toolbar Scan the pages can be inserted by scanning. 
 

Replace one page 
To replace single pages in a document, choose the tab Scan in the Control Box of the 
cabinet. Select the desired (??? wanted/ designated)  scan profile and choose the 

document and open it. Select the page you want to replace and click    to replace one 
page. 
 

Replace all pages 
With the command „Replace all pages“ from the toolbar Scan the pages can be 
replaced during the scan process. The pages which were scanned before can be viewed 
in the revision. 
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Stop scanning 
The scanning can be any time stopped by clicking to  in the control box of the 
cabinet. 
All new documents are created and stored in the local document list. In this list the 
document and its index can be edited if necessary. After checking in to the server 
the documents can be retrieved. 
 
 

Import documents 

Import list / Import - Index 
 

 

 
With File → Import index fields can be imported from a text file. In this text file the 
fields must be separated by a field separator. This field separator must be 
specified in the import template.  
 
Index data can be imported as follows: 
 
Define import file (*.txt, *.dat,*.csv etc.) with field separator or export a file from 
another application. 
If one or more file names of image files are specified at the end of each line of this 
text field and these files are stored in the import directory, they are imported to the 
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according index information as pages.  
 
The content of a text file to be imported could be the following:  
 
Helmut,Meier,01234,imagename1.tif 
Rita,Schmitz,56789,imagename2.tif 
 
 
Execute File → Import 
Select source file. This is the text file described above.  
Specify field separator which is used in his file (here: comma) 
Set number of text fields from the text file 
Select document type to which the data should be imported. 
Set field connections. The source index is the column of the text field and the 
target field is one the index fields used in the document type selected before.  
 

Left / right trim: 
This function allows to cut off control characters which may be exported to the text 
file if it was generated from another application. An import file may look as follows: 
 
^Helmut^,^Meier^,^01234^,^imagename1.tif^ 
^Rita^,^Schmitz^,^56789^,^imagename2.tif^ 
 
The special character ^ around each field can be can be cut off during import. 
 

Ignore line starting with a special character 
With this option the character at the beginning of a line in the index file can be ignored 
when importing. In some cases it can be helpful to have comments in an index file or 
when some lines should be ignored. If you use files which were exported from another 
program it also can be necessary to ignore several lines. 
 

Full line is filename 
If the filename of a document already contains the index data this option can be used: 
 
Example:  
The name of the files is as follows:             12345_Meier_Duisburg_01.jpg 
       22233_Schmitz_Köln_02.jpg 
 
The index file is stored in the same directory and contains the listed file names: 
 
Index.dat: 
12345_Meier_Duisburg_01.jpg 
22233_Schmitz_Köln_02.jpg 
 
The index settings are configured using a „_“ as field separator. Specify the number of 
index fields and assign the position within the file name to the index fields of the relevant 
document type. 
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Import from all directories 
If there are several directories on the same level containing index data, which contain an 
index file which is named as the first selected index file name (in this case: index.dat), the 
import is processed for all the directories when this option is set. With this option it is not 
necessary, to select the next index file in a different directory manually for import. 

Bundle all pages 
If this options set, the import works like a batch scan. All documents with the same index 
data are written into one document. If this option is not set, all image files are imported as 
single page documents. 

Test Import 
If the settings lead to a good result and if there are any configuration errors can be 
checked by the test import function. A file *.testresult will be created in the import 
directory containing the test results. This file can be checked with an editor. 
 
Test import only checks the import structure, not the complete document data to be 
imported. 
 
 
Hint: 
With manual index import in WinClient new documents can be imported. The 
imported data are created on the local document list and have to be checked in. If 
documents from an index import should be edited and amended this must be 
performed with a server based index import. This index import scheduler can only 
be configured by an administrator in Enterprise Manager. (→ see Administration 
Guide) 
 
 
In Version 1.2.3 and later File and Index-Import can also be processed automatically with 
a server based scheduler.  
 
Import successful / not successful 
When import has finished, a message appears stating if the import process was 
successful or not. If the import procedure was not successful, but has been executed 
anyway, the index file may have pointed to not existing images. In this case please check, 
if the images are all located in the same path as the index file.  
 

Special scan options 

Skip first page with barcode (separation sheet) 
 

/skipbarcodepage 
 
This application is often used for the digitalization of data when barcode pages are used 
as batch separator during the scanning process. 
 
To delete the first page which contains one or several barcodes after a batch scan , the 
WinClient must be started over a link with the start parameter „/skipbarcodepage “ 
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Procedure: 
Create a link to the program start of the WinClient and write the option behind the path: 
 
C:\Program Files\Dieter Spielberg DMS GmbH\FileDirector WinClient\ FileDirector 
WinClient.exe /skipbarcodepage 
 
Hint: 
To set the parameter it’s not possible to use the automatic created start link icon of the 
WinClient on the desktop. For running the WinClient with the parameter create a new link 
to the WinClient. 
 
 

Component Service (Office 
Link)  

What is an electronic document (Edoc)? 
 

Each file format created outside of FileDirector and not being a standard image 
format like TIF or JPEG is treated as a propriety file format. Example for these file 
formats are Microsoft Word, Excel and PowerPoint, Emails in Windows MSG 
format, Adobe PDF files or AutoCAD files. In FileDirector we call these formats 
„electronic documents“ (Edocs). 
 

How are Edocs stored in FileDirector? 
 

Each Edoc is saved as a page of a FileDirector document, even if the file itself 
contains several pages. If you want to display such a „page” of a document the 
Component Service must be installed because it contains a viewer for a lot of 
the electronic file formats.  
 

How can Edocs be displayed? 
The Component Service contains the Stellent Viewer, which allows the display of 
different file formats without the relevant application being installed on the PC. 
 
The viewer supports more than 200 different file formats including the most 
important propriety formats. Example for these formats are Microsoft Word, Excel 
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and PowerPoint files, Microsoft MSG Email files, Adobe Acrobat PDF files and 
AutoCAD drawings. 
 
Editing of these formats is only possible, if the application is installed which 
created the files. 
 
The viewer is only meant to display and print the electronic documents. It cannot 
recognize and display each and every format detail or special setting of the 
original file. Therefore the display of electronic documents in FileDirector can be 
different to the display of that document in the original application. 
 
Hint: 
The support of the Component Service for Windows 98 and Office 97 (and earlier 
versions) is discontinued. 
 

Selection of a page when displaying Edocs 
 

The browsing through an electronic document depends on the file format. In a 
Microsoft Word file a vertical scroll bar is used to navigate through the pages of 
the document. In other file formats like Microsoft Excel, PowerPoint and Adobe 
Acrobat navigation tools are displayed in the bottom par of the display window. 
These tools allow browsing page by page or a direct selection of the page. For 
each page of the file a kind of tab is displayed with Image and the relevant page 
number. Left to the tabs the navigation tool are displayed: 

  Display tab of the first page of the file 

  Display tab of the last page of the file 

  Display tab of the previous page of the file 

  Display tab of the next page of the file 

  Display previous page of he file 

  Display next page of the file  

Tools for page display 
 

Select from toolbar Display or from context menu of right mouse button the 
following commands in order to fit the relevant page to the display window.  
Eventually a vertical scroll bar appears, which you can use to move he displayed 
part of the page in he display window. 
 

 Fit width to the document display window 

 Display page in original size 

 Zoom in (enlarge display) 
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 Zoom out (decrease display) 
 
 

Indexing of electronic documents 

Requirements 
If you want to use Office Link Component Service must be installed on the client. 
It must be present if you want to archive via Office and as well if you want to use 
Drag and Drop. 
 
When Office link should be used, the Office Components Word, Excel, Outlook 
and PowerPoint must be installed.  
 
Hint: 
Office 97 and earlier versions are not supported. 
 
Hint: 
During the installation of the component service you can choose wether it will be installed 
for the user who installs or for all users. When it is installed only for the one user the 
button in office does not exist for other users. 

Indexing from Microsoft Office  
 

During installation of Office Link a button  for archiving is created in the Office 
applications. 
 
When electronic documents should be indexed the cabinet should be opened in 
the background to which documents are stored.  
If a document is archived an index template opens up, where the target document 
type and the index for this document can be specified.  
 
If WinClient is not open, the index template appears directly when WinClient is 
opened for the next time. 

Create a document for example in Word and click to the FileDirector button .for 
archiving. If WinClient is open, the index template appears.  
Since version 1.4 the WinClient need not to be opened in the background, 
because a cabinet can be chosen in the FileDirector index capture window now.  

The index capture 
Choose the target cabinet and document type where the document is to be archived to 
and fill the index fields in the index capture window. 
 
When clicking to OK the index information is stored for the current document.  
 
If several documents were sent to FileDirector for archiving the same index can 
be stored for each document. 
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The document appears after archiving on the local document list. It must be 
checked in in order to be available for retrieval. 
 
  

 
 

Revising of electronic documents 
When an electronic document was checked in and must be revised, open this document 
in the WinClient and have it advised. 
 
By using the context menu of the right mouse button in the document window you can 
start the application. The used application opens. After changing the document in this 
application you are asked when pressing the FileDirector button to save the document 
whether the document should be checked in again to apply the changes. To avoid that 
the document is changed by other users it is possible to check it out before it is edited in 
the application.  
 
After the changes archive the document by using the FileDirector button and a revision of 
the document is saved. Please check in the document  again after editing it.  

Several fields as a unique index 
In the lower part of the index template some navigation buttons can be found. 
These buttons become active, if several fields must be defined as a unique index. 
This is a configuration which must be predefined by an administrator user. 
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A client number can for example be a unique index. The index may no be used 
twice.  
 
If for example two index fields must be filled out to create a unique index, the 
selection can be done with the navigation buttons. 
 
Example:  
The number ranges for client numbers are identical for different areas. It is 
possible that a client number 4711 exists as well in area A and in area B.  
 
In his case only the first two fields together form a unique index (for example 4711 
and A). Now specify the first index and click to OK. Now the system finds that this 
is not yet a unique index and it allows to select the area in the second field with 
the navigation buttons in the bottom toolbar.  

Office Quick Start 
 
If Microsoft Office is installed, the applications can be started via the 
buttons of the quick start bar directly from WinClient.  
 
In Extras → Options additional applications can be integrated to the quick 
start bar of WinClient in tab „Misc“ by dragging and dropping of the 
application to the configuration template in “Misc”. 
 
 
 
 

 

Indexing using Drag & Drop 
 

In order to archive electronic documents any file can be selected in windows 
explorer, dragged and dropped to the menu area of the WinClient desktop or the 
area of the list names below the display part.  
 
A question is prompted: „Save all files to one document?“ If this question is 
answered with Yes, the index template appears only once for the complete 
document. All files will then be stored as one document under the index specified.  
If the question was answered with No the index template appears for every single 
file. 

Save filename as index 
An administrator user can setup an index field, that the file name is used for 
automatic indexing. The index field must be defined to be able to take the file 
name as index.  

Send to FileDirector  
This function is also available in Windows explorer via the context menu of right 
mouse button. Select the files to be archived and select command Send to → 
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FileDirector. The functionality of the index template is the same as described in 
Drag & Drop.  
WinClient must be open; otherwise the index template will not appear.  
 
 
Before version 1.4 the index capture window only appears if the WinClient is open. In 
version 1.4 or later this is not necessary anymore. 
 
Hint: 
If the command „send to…“ is usedwith right mouseclick and several pages are selected 
in the Microsoft Windows Explorer, the page on which the rightclick is done will be the 
first page. 
 

Capture Emails from Outlook 
 
To capture emails from Outlook the emails are archived with a button from 
FileDirector which is available after the installation of the component service. 
 
In the normal case the emails are saved as complete *.msg file. Since version 1.4 
the attachments can be saved as separate page in the original format and are 
appended to the document. 
 
The Component Service can be configured to save the attachments separate as a 
basic principle or the user can be asked how to save the document with 
attachment. 
 
To setup this option, open in the program path of the Component Service the file 
FileDirector Component Service.exe.config with an editor. After a standard 
installation the path of the file is: 
“C:\Program files\Dieter Spielberg DMS GmbH\FileDirector Component Service”. 
 
In this file the following options exist: 

Save email attachments as separate pages 
 
To save email attachments as separate pages, the following option can be set in the 
above mentioned file: 
 
<add key="EMailSplit" value="Off" /> 
This value can set to “value = “Ask”, „On“ or „Off“. 
 
 
Off =  Emails are saved as comlete *.msg File and attachments can be opened when the 

email is opened with office again (Rightclick, run Application). This requires that 
on each pc where the attachement is to be opened the office must be installed. 

 
On =  The attachments of emails are saved as separate pages of the document and the 

body is saved as html page. 
 
Hint: 
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If there are pictures in html pages, they are also saved as separate pages in the 
document. The links in the htlm file cannot be displayed. 
 
 
Ask = With this option the user is asked during the archiving in outlook wether the 

attachments are to be saved as separate pages or not. 
 

Save attachments as separate Documents 
When the attachments have to save as separate document and not only as separate 
page, the following option is to be set to “TRUE”: 

<add key="NewDocsForAttachments" value="TRUE" /> 
The default value after an installation is “FALSE”, that means not activated. 
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Sending and receiving 

Send documents by Email 

Sending by Email - General 
The Email option of FileDirector allows sending of single or selected documents 
as well as single or selected pages of a document by Email. 
In order to use this feature you must have a valid Email account and a MAPI 
compatible Email client must be used on your PC. 
If the document to be sent only contains black/white images, a multipage TIFF file 
is created and appended to the Email. 
If the document contains several file formats, the TIFF files are bundled and 
appended as a Multipage TIFF file. Colour pages are appended as JPEG files, 
any other format is directly appended to the Email in its original format. 

Append as *.pdf - format 
With a setting in Client the attachments to the Email can automatically be 
converted to PDF format. This is set in Extras → Options → Misc. The 
advantage of these settings is that the recipient of the Email only needs a free 
available Acrobat viewer to read the document. Additionally it cannot be edited 
and a *.pdf file is normally smaller than the original, which is an advantage when 
sending via Email. 

Configuration of filename for Email appendage 

Default procedure without settings 
The file name of a TIFF file contains a time stamp, where the date and the time of 
scanning is stored. 
This file name is used if the user right clicks to a data record of the hitlist on the tiny 
square used to select documents and if command Send to Email is used. The subject and 
the file name are named accordingly. 
If the send command is used from the context menu when clicked on one of the index 
fields, the index information is used as the file name. 
 

Configuration of file name 
The file name can be set manually, if an option in the WinClient settings is configured. 
Open options menu in extras: Options → Misc.. The file name to be used can be 
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configured to be made up of three parts and a field separator. The file name is assembled 
from these parts when Send to is used. 
The relevant parts can be index information, a date field or the document type name. If a 
date field is used, one index field of the relevant document type must be configured to 
contain a date. If there are several date fields, the first date field is used. 
 
Hint: 
These settings may already be predefined in a client configuration in Enterprise Manager. 
In this case the user might not have the right to change this setting. 

Sending of a single document 
Select the document to be sent in the document list.  
Select Send to  and then Email  via context menu of right mouse button. 
Your Email Client will open a new message and append the document to this new 
message. You have to specify a target and possibly a message to this new Email. 

File name of the appended document 
If the whole document is sent, the content of an index field can be chosen as the file 
name. In this case the mouse cursor must be positioned on the index field to be used for 
file naming. Open context menu with right mouse button in this situation and select the 
Send to   → Email   command. 

Sending of several documents 
Click to the first document of the document list and keep the SHIFT key pressed. 
Click to the last document of the document list you want to send and select Send 
to  and then Email  via context menu of right mouse button. 
Your Email Client will open a new message and append the selected documents 
to this new message. You have to specify a target and possibly a message to this 
new Email. 

Sending selected documents 
Click to the first document of the document list and keep the CTRL key pressed. 
Select the documents to be sent. Select Send to  and then Email  via context 
menu of right mouse button. 
Your Email Client will open a new message and append the selected documents 
to this new message. You have to specify a target and possibly a message to this 
new Email. 

Sending of one page of a document 
Open the document and display the page to be sent. 
Select Email  by clicking with the right mouse button on the thumbnail of the 
currently displayed page 
Your Email Client will open a new message and append the selected page to this 
new message. You have to specify a target and possibly a message to this new 
Email. 
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Sending of selected pages of a document 
You can select pages of a document in the thumbnail view of the display window 
for sending. In order to view. Open the relevant document; display the pages 
either in Thumbnail view and image or Thumbnail View only. 
Keep the CTRL key pressed and click to the pages to be sent in the thumbnail 
view. 
Select Email  by clicking with the right mouse button on the thumbnails. 
Your Email Client will open a new message and append the selected page to this 
new message. You have to specify a target and possibly a message to this new 
Email. 
 

Send eMail as link 
When a document is sent via the function eMail as Link, a link will be created 
automatically in the clipboard for the WinClient and for the WebServer to call the 
document. 
After a new email is opened, the clipboard can be copied to the email body. 
The links are composed (assembled) of the fragments which are preconfigured in 
Extras → Options → Misc. 
 

Send Documents to users 

The personal folder 
Documents can be sent to other FileDirector users. The received documents 
appear in the personal document list of the user. When sending a comment can 
be added as a note for the recipient who is displayed when the document is 
opened. 

Sending of documents  
Select the document to be sent in the document list. In context menu of right 
mouse button use Send to  and select the target user . When sending a 
comment can be added as a note for the recipient who is displayed when the 
document is opened. 

Selection of a range of documents 
To print several documents which are listed one after the other on the document 
list, click to the first document of that range, hold the SHIFT key and click to the 
last document of that range in order to select them. 
Select Send to  and User  via the context menu of the right mouse button.  

Selection of single documents  
In order to send several selected documents from a list, click to the first document 
to be selected, hold Ctrl key pressed and select more documents. 
Select Send to  and User  via the context menu of the right mouse button. 

Notification 
Under Extras → Options → Notification a notification mode can be set.  
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Hint:  
If a notification is specified with a short time interval, WinClient always 
reestablishs a connection to the server. In this case the license may not be freed 
for another user. 
See → also General settings/Options 

Send to … Info 
If a document is sent to a user the info of the document shows to which users the 
documents was already sent. Select the document and execute in context menu 
of right mouse button Document Info. The information is listed under tab Send 
to….  
 
See →  also Info of documents 
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Process management * 

What is process management 
A process in Filedirector is a predefined number of Steps. During these steps 
documents are sent to FileDirector users. The users have to perform specific 
actions in order to finish a process step. Any number and configuration of 
processes can be set up by FileDirector administrators. Documents are 
introduced to processes by a sending function. 
 

Send to process 
Processes must be defined if a document should be sent to a process.  
Documents can be sent to processes either manually or automatically.  
 

Manual sending of documents to processes 
 

 
 
To send documents manually to processes proceed as follows: 
Select the document to be sent 
Select from context menu of right mouse button Send to… → Process. 
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Select the process to be used. Which process should be used must be checked 
with the administrator who configures the processes and adjusts them the 
companies needs. 
In field Comment a comment can be entered for each document to be seen by 
the next recipient.  
With OK the document is sent. 
 

Automatic sending of documents to processes 
In FileDirector Version 1.2 and later conditions for processes can be specified 
depending on index values.  
 
This simplifies the selection of processes for a user, because a document selects 
a process automatically according to a defined index field content. The user does 
no have to select a process manually. 
 
An automatic process can either be started when checking in new documents or 
when changing documents already archived.  
 

Receiving of documents from a process 
 

Each document received by a user from a process is stored in his personal folder. 
The action which the user must execute is displayed in column Action of the 
personal hitlist.  
If you open a document sent by a process a button is displayed in the display 
window to execute the relevant action. Additionally the comments are displayed 
which may already have been added by other users. 
 
After you have executed the action required the document is closed and send 
back to process management control. If necessary you can keep a link to the 
document in your personal folder by selecting check box Keep local copy before 
executing the required action. 

Process actions 
For each document received by process management you have to execute the 
required action for the relevant step. The document will stay in your personal 
folder if either the required action is executed or the time delay specified is 
reached. Afterwards process management again takes control of the document. 
 
The following actions can be set: 

No action 
Action None is used to send a document to a user during a process for 
information purposes. This action does not influence the process at all. 
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Confirm view 

 
 
If action View is specified for a document, you must confirm that you have take 
notice of it by clicking to a button. Afterwards process management can take the 
document to the net step of the process. 
The action is performed a follows: 
Open the document in your personal folder 
View the document  
Select Keep document, if you want to keep a local copy in your personal folder. 
Click to button Confirm View in order to execute that process Step. 
If Keep document is not set, the document will close and will disappear from the 
personal folder. If Keep document was set, the document remains and a copy is 
maintained in the personal folder. 
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Comment document 

 
 
If a document step has action Comment assigned, you must read and add a 
comment. Afterwards process management can carry the document over to the 
next process step. 
The action is executed as follows: 

 Open the document in your personal folder  
 Read the document 
 Select Keep document, if you want to keep a local copy in your personal 

folder. 
 Click to button Comment in order to open the comment field. 
 Enter the comment 
 Click to OK 

If Keep document is not set, the document will close and will disappear from the 
personal folder. If Keep document was set, the document remains and a copy is 
maintained in the personal folder. 
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Approve/Reject document 

 
 
If action Approve/Reject was assigned to a process step, the document must be 
read and then the user must decide whether the document is approved or 
rejected. In both cases a comment can be added. 
 
The action is executed as follows: 

 Open the document in your personal folder  
 Read the document 
 Select Keep document, if you want to keep a local copy in your personal 

folder. 
 Click to button Approve or Reject in order to open the comment text field. 
 Enter comment if necessary 
 Click to OK 

If Keep document is not set, the document will close and will disappear from the 
personal folder. If Keep document was set, the document remains and a copy is 
maintained in the personal folder. 

Check user actions 
User actions can be defined during the configuration of a process. A list of entries will be 
defined which must be completed before the user can confirmed. This list can be set up 
user specific. As long as not all checks are completed the document can only be rejected.  
 
Which options on the list were checked can be seen in the comment of the document 
later on.  

Keep document 
If a document is kept and stored in the personal folder after the process action 
was executed, it can be deleted any time from the personal list. This does not 
delete the stored server document. The stored document gets status Archived 
and must be checked out if it should be edited again. 
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Hint: 
The legend of the buttons can be changed as well during the configuration of a process. 
Therefore there might be another text as e.g. “approve document“, “reject document“ or 
“approve view“. 
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Process Status 
The current status of a document on a process can be displayed. For each 
document the process name, the user where the document is currently located 
the action which he must execute, the name of the user who sent the document to 
the process and the date and time when the document was sent to the process. 
The document which is during (in) a process can be retrieved and commented from the 
process status. 
 
 
Select Process State  from menu Extras in order to display the process status 
list. 
 

Process Info 
Select the document and open from context menu of right mouse button the 
document Info. In tab Processes the steps can be seen which have already been 
performed. 

 

 
 

Add comment 
If a document is on a process, with the document info.you can write a comment to the 
document at any time. 
 

Print process list 
The list of the processes executed can be printed by clicking to Print. 

Cancel Process 
If a running process should be cancelled, this can be done in WinClient by clicking 
to the relevant button in document info. 
 

Signing of Documents with signpad 
Process management can be designed that documents must be signed to 
approve them. A licence and a special hardware are necessary for this.  
A sign pad is used for signing for which a driver must be installed first. 
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Install sign pad 

 Sign pad from signotec 
 
In order to install the sign pad connect it with a free USB Port of your work station. 
On the FileDirector installation CD a directory „Sign pad driver” is stored 
containing the driver. Start file SETUP.EXE and follow the installation menu.  
 
Hint: 
a) NT4 does not support USB; therefore the Pad can not be installed 
For Windows 98 a windows driver for usage of USB ports must be installed. 
 
b) Up to now the software only supports the signotec sign pad. 
 

Setup signatures 
The program needs three stored samples of your signature for recognition. These 
must be stored by the user. 
 
If he driver was installed properly, the pad should react like a mouse cursor. Open 
WinClient for the configuration of signatures and click to Extras → Options tab 
Signatures.  
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Click to the button right to the first signature box and create a sample signature. 
After clicking to OK the second sample box opens and you can create a second 
sample. Fill out all sample signatures. The signature can be tested by clicking to 
Check signatures. If you enter your signature again, it will be compared with the 
three samples. If green buttons appear at the sample boxes, the signature was 
recognized correct. 
If red buttons appear, the recognition did not work. If this is the case, the 
signatures may be too different and should be repeated 
 
Hint: 
 
The sensitivity for the signature recognition can be set in the web.config file of the 
FileDirector server. Please ask your administrator for modification. 
 
  <add key="FDServer.SignatureThreshold" value="80" /> 
 
Please refere for further details of the settings of the configuration file to the installation 
manual. 
 
 

Deleting of signatures 
In order to repeat a signature configuration it may again be specified in the 
configuration template. To delete a signature completely for a user an 
administrator user is necessary to do it in Enterprise manager. 
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Set up absence 
When using the process management, the documents are sent to different users for 
editing. The user sees the document on his personal list. When a user is e.g. on holiday, 
he can specify a period for an appointed assistant. The appointed assistant had better 
sufficient rights to edit the document and to deputize the user adequately.  
 

 
 
The absense can be set with Extras → absence settings. 
 
If a user was not able to set up the properties himself, it can be done centrally by an 
administrator in the Enterprise Manager to provide that the documents can be edited by 
an agent.  
 
Hint: 
If this option is not available, you might add this command by using “customize“ 
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Information of documents 

Logging of document information  
 

Each action that takes place with a document in FileDirector can be logged. A list 
of these actions can be displayed by an administrator user.  
A description of the document information is give below, general information like 
when the document was created by which user, its size and the number of 
revisions. The document history contains a list of retrieval activities and 
modifications. Further information is stored about process activities and sending 
of documents.   
 

Info: Document  
Select the document to which you want to display information. With Document 
Info  in context menu of right mouse button the document information can be 
retrieved. The information is displayed in a Document-Info-Window.  
 

Information Description 
ID Unique number (ID) of the document 
State Actual status : Archived, Checked Out, Read only 
Pages Number of pages 
Revisions Number of revisions 
Created on Date of first storing in the cabinet on the server 
Created by User account which performed first storage 
Checked out on Date/Time of Check out 
Checked out by User account who executed Check out 
Size Storage space needed for the document 

 
 

Info: History 
Select Document Info  in context menu of right mouse button on the document 
list. Select tab History of document info window. 
 
The document history contains a log, which lists who retrieved and changed the 
document.  



FileDirector 2.0 Information of documents    97 

 
Information Description 
# Number of the listed action 
Action Type of action: Retrieved or changed 
Created on Date/Time of action 
Created by User account involved 

 

Info: Processes 
Select Document Info  in context menu of right mouse button on the document 
list. Select tab Processes of document info window. 
 
In Processes all actions are listed which are executed on this document by 
process management.  
 
 
Information Description 
Process Process name 
Step Number of step in process 
User User account involved in this step 
Action request Action requested from user 
Action response Action taken by user 
Aktion taken on Date/Time of action taken 
Comment Comment added during execution 
Signature Signature used by user for action 
Created by User account involved when sending 
Created on Date/Time when document was sent 

 

Info: Send to 
Select Document Info  in context menu of right mouse button on the document 
list. Select tab Send To of document info window. 
 
Send to contain a list of users which have received and sent the document. 
 
  
Information Description 
User User account to which the document was sent 
Comment Comment added to the document 
Created by User account from which document was sent  
Created on Date/Time when document was sent 
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Page-Information 
 

Select Info   in context menu of right mouse button when clicking on the 
currently displayed page in the display window. Information about TIFF or JPEG 
pages is listed. 
 
 
Information Description 
Cabinet Name of cabinet where document is stored 
Document type Document type, to which document type is stored 
Document ID Unique number (ID) of the document 
File type File type (TIF or JPEG) 
Width (Pixel) Image width in Pixel 
Height (Pixel) Image height in Pixel 
Resolution X (DPI) Horizontal resolution 
Resolution Y (DPI) Vertical resolution 
Colour depth (Bits) Colour resolution in Bits 
Uncompressed size Size of uncompressed image 
Compressed size Size of compressed image 
Compression rate Compression rate in Percent  
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General settings/Options 

General 
With different settings WinClient can be configured to execute certain actions 
automatically, for example to display the cabinet list automatically. 
 
These settings can be stored per user on the FileDirector server and be 
downloaded to WinClients opened by this user. In this way a user profile can be 
loaded on different work stations. 
 
To change this settings select Options  from menu Extras and select tab 
General. If settings are changed they are stored with clicking OK. 
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See also → Automatic Check in / Settings in Options 

Open last used cabinet 
When set, automatically the cabinet last used is reopened when starting 
WinClient.  
Click to Open last used cabinet to activate and deactivate this setting. 

Remove new documents after check-in 
When activated new documents are automatically removed from the local list 
when they have been checked in to the FileDirector server. Click to Remove new 
documents after Check in to activate and deactivate this setting.  

Remove revised documents after check-in 
When activated revised document are automatically removed from the local list 
when they have been checked in to the FileDirector server. 
Click to Remove revised documents after check-in to activate and deactivate 
this setting.  
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Remove local documents after sending to process 
When using the process management the documents which are sended to a process are 
saved in the personal folder of the users. If a document is to be deleted after an action is 
taken by the user, e.g. approve/reject, this option can be set. 

Don’t remove from search result list 
After changing of index a document is checked-in again and disappears from the 
search list. With this option set the document remains on the search list even if it 
does not match the search criteria anymore after the index change.  

Auto. Check-In new documents 
If new documents are created, they are normally stored on the local document list 
on the work station and have to be checked-in from this list. With this option new 
documents are immediately checked in. If index has to be changed or added, they 
have to be checked out again. 

Auto. Check-in new documents after edit 
With this option set new documents are automatically checked in to the server 
after the index has been edited. 
Click to Auto. Check-in new documents after edit to activate and deactivate 
this setting. 

Auto. Check-in revised documents after edit 
With this option set existing documents are automatically checked in to the server 
after the index has been edited. 
Click to Auto. Check-in revised documents after edit to activate and deactivate 
this setting.  

Reminder to check in new documents on program exit 
With this option set the user is informed that new documents are still stored on the 
local list which have not been checked in yet. This reminder appears when the 
user closes WinClient. 
Click to Reminder to check in new documents on program exit to activate and 
deactivate this setting. 

Reminder to check in documents on program exit 
With this option set the user is informed that new or changed documents are still 
stored on the local list, which have not been checked in yet. This reminder 
appears when the user closes WinClient. 
Click to Reminder to check in documents on program exit to activate and 
deactivate this setting. 
 

Check integrity of unsigned documents 
A check sum, a so called “hash code“ is being generated for each document. When 
changes of the data of a document are made in the file directory of the server, the check 
sum does not match with the original data. Therefore you can check a manual change of 
the data which will be displayed with a red icon in ther WinClient.  
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Language 
The language used by WinClient can be selected. As default the language of the 
operating system (Windows) is used, but it can be changed to the following 
languages: 
 
English (UK) 
English (US) 
Deutsch 
Français 
Espaòol 
Dutch 
Japanese 
Korean 
Chinese (Big5) 
Chinese (Simplified) 

 
If you switch to select a different language select a language from the drop down 
list and click to OK. Afterwards WinClient has to be restarted.  
 

Delete MRU List 
With the MRU lists (most-recently-used) the entries are listed which are already typed in. 
To delete the MRU lists, use Extras → Options → delete MRU list. 
 

Misc. 
To change these settings click to Options  from menu Extras and select tab 
Misc. If settings are changed they are stored by clicking to OK. 
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Hint:  
Even if the usage of the options properties by a client configuration is not enabled, the 
properties of the tab “Misc.“ are available although, because these settings should be 
adjustable differently for each workplace.  
 

Convert to PDF 
With this option set the documents which should be appended to a new Email 
(Send to … Email) are automatically converted to PDF and then appended. 
If you want to change this setting click to Convert to PDF. If this option is not set 
documents are appended in original file format (tif, jpg, Edoc). 

Assembling of file name for Email attachement 
In these optional settings the file name can be build, which is used to attach a file to an 
Email. The separator is the character to be used between the single parts of the name. 
See → Send and Receive 

WinClient126_for_trans.en.doc
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Exact scale print 
With this option set, documents are printed in their original size exactly like they 
were scanned. The image is not fitted to the output format.  
 
To activate or deactivate this setting click to Exact scale print. This option is 
mostly used to print scanned construction plans and maps in original size. 

Print using smart page rotation 
As a document is printed the page format is fit to the format of the printer and 
automatically rotated. This option can be used, if e.g. A3 and A4 documents are to be 
printed and must be different rotated on several printers.  

Reset Zoom when displaying new page 
With this option set the zoom factor is not kept if the display switches to a new 
page. 
To activate or deactivate this setting click to Reset Zoom when displaying new 
page. This option is useful when indexing several similar documents manually 
where the zoom settings should be kept.  

Use area post-indexing 
If this option is set, the zoom parameter is saved for each index field individually. This 
allows for a fast and easy manual indexing. If the field contents are always located at the 
same position, the zoomed part always “jumps” to the right location. 

Show post scan options 
If this option is checked, a window appears after batch scanning, which allows controlling 
the next actions manually: 
 
Save scanned pages 
The scanned pages are stored as one document. 
 
Scan new batch 
After a scanning process has been terminated, immediately a new document should be 
created when a new batch of pages is scanned. 
 
Continue scanning 
Scanning can be continued and further pages can be appended to the actual document if 
this option is selected. 
 
Delete last page 
Sometimes index- or separation pages are inserted between the documents. If this option 
is set, the last page scanned is automatically deleted. 
 

Show line number in document lists 
By selecting this option the line number will be shown at the beginning of each line in the 
hit list.  
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Rotational line colours in document lists  
Providing a better overview of a hit list the lines can be shown in rotational line colours. 
The colours of the lines are forced by the system.  

Show documents immediately  
By selecting this option the content of a page will be shown immediately after the first 
click on this page and it is downloaded to the local cache. When this option is not 
selected the page will be shown and downloaded only after perfoming a double click. 

Allow floating control and list windows 
 
Dynamic arrows showing possible positions appear during positioning of 
control bays and lists via drag&drop. Providing this way of free 
positioning, this option can be set. When this option is disabled, control 
bays and document lists can not be moved freely. 
 
 
 
 

Custom quick start program 
When Component services are installed an Office quick start toolbar is created in 
WinClient. Office must be installed on the PC. This quick start toolbar can be 
expanded by an additional application which should be available very quick from 
FileDirector. This application is added by a Drag and Drop operation. 
 

 

Notification 
To change this settings select Options  from menu Extras and select tab 
Notification. If settings are changed they are stored with clicking OK. 
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With these settings a notification can be switched on and configured for the arrival 
of new documents on the personal list. 

Disable client notification 
Select this setting if you do not want to be notified if a new document has arrived 
on your personal folder.  
To activate this setting click to Disable client notification. 
 
Hint: 
Note that if notification is switched on the client will connect to the server in a fixed 
schedule. This may prevent that the license used is freed again and thus blocked. 
A manual pick up is possible with key F5. 

Scheduler based passive notification 
Select this option if you want to be notified upon arrival of new documents on your 
personal list. 
To activate this setting click to Scheduler based passive notification. 
Specify the interval in minutes which WinClient should use to check for new 
documents in your personal folder. Select the types of notifications in Notification 
options. 

Notification options 
Select any combination of the available notification types for your personal folder. 
 
Display document list: 
When new documents arrive in personal folder the document list of the personal 
folder is displayed. 
 
Icon in task bar:  
A folder Icon  appears as notification for the arrival of new documents in your 
personal folder. The number of new document is displayed if you position the 
mouse cursor on the folder icon. 

 
 
Display message: 
As notification a message window is opened, which informs you about the arrival 
of new documents in your personal list. 
 
Play sound: 
As notification a sound is played, which informs you about the arrival of new 
documents in your personal list. 
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Signatures 

Sign documents 
There are different ways in the FileDirector to sign a document. 
You must differ between an electronic signature and a personal sign. 
 
An electronic signature is used to proof the authenticity with a certificate when the 
documents are sent to the server. These documents can not be manipulated then, 
because the original documents are checked. 
 
In comparison to that a personal sign is a way to sign a document similar like on the 
paper. 
 

 

Load a certificate 
When a document type is configured only to accept signed documents, the user needs a 
certificate. This certificate must be provided to him and can be loaded from the 
appropriate storage or storage medium. 
 
 
The following stores (possibility of saving ?) are selectable: 

http://dict.leo.org/ende?lp=ende&p=/gQPU.&search=authenticity
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AD user store (Active Directory user store) 
Current user store  
Smart card store  
 
To get a certificate and to know from which server the certificate can be loaded, please 
ask your administrator or an official trust center. 
 
 

 

Using of a scanned and stored personal sign  
Usually a document must be signed on the paper before it is scanned. With FileDirector 
you can place a scanned signature into the tif file later.  
 
To use this feature you must scan your signature and load it with the command „Choose 
your signature image“. A password must be defined for the user to ensure that only the 
right user has access to his signature. Every user can predefine three signatures e.g a 
normal signature, a short signature and a legible signature. For all three signatures the 
password must be identically, because only one password is requested when the user set 
the signature as annotation. If there is already a password stored, the button with the 
number will change to boldface. 
 
 
When a signature is set to a tif file, it is dedicated to the picture. Use the command 
“Annotations → signature” from the right mouse context menu in the page view to set a 
signature. 
To set the signature the password must be entered now. 

Define electronic signature for processes * 
In this area you can define a signature with a special sign pad to use it later in a special 
process action. 
E.g. a process can be defined when a document is approved by using a signature. The 
next step of the process is only done if the signature is valid. 
 
→ Read for these settings the topic „Sign documents“ in the chapter „process 
management“. 
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Cache (local) 
 

To change this settings select Options  from menu Extras and select tab 
Cache. If settings are changed they are stored with clicking OK. 
 
 

 
 
For each WinClient user a separate cache is created on the work station, where 
local documents and copies of the documents recently displayed are stored. You 
can specify if the copies of the recently displayed documents are kept when 
closing WinClient. 

Purge Cache after program exit / logout 
When this option is active all copies of the recently displayed documents are 
deleted if you close the WinClient or log off. If this setting should be changed, click 
to Purge Cache after program exit / logout. If this option is set but WinClient is 
running for a long time the cache is automatically deleted after 12 hours to 
prevent large amounts of data to collect in WinClient cache. 

Document storage cache (Cache Directory) 
The storage location for the local cache is displayed here. Normally the cache is 
located in a subdirectory “FileDirector” under “My documents” on the workstation. 
For each user of WinClient on this PC an own directory is created. 
 
The setting of the cache path can only be viewed here. The configuration is done 
via the Windows settings of directory „My documents“.  
 
If the local cache should be controlled with a server profile, the administrator can 
specify a configuration to relocate the local cache. 
 (→ see Installation Guide) 
 

Connection 
 

To change this settings select Options  from menu Extras and select tab 
Connection.  
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Multiple connections can be established to different servers, though one connection to 
one server is the normal case. The effective connection is selected and confirmed by 
clicking OK. The new setting will be applied to the WinClient with the next start up. 
 
 
Hint: 
The connection with multiple server is available from version 2.0 on. A WinClient version 
2.0 should only be connected to a server version 2.0. Error messages can arise if a 
connection to a server of an earlier version is established. 
 
 

 
 
 
 
When installing WinClient on a workstation from the FileDirector Server the 
connection is configured automatically. This settings are the sever address (URL) 
the connection mode and the language of the WinClient desktop and menus.   
 
If this window appears when starting WinClient ask your system administrator for 
the address of the FileDirector server and enter the URL of the server. If the 
connection settings are made once they are stored in file Settings.fdl in local 
Cache of WinClient. 

Server URL 
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With “Edit connection” settings for the server URL become available. This setting holds 
the location of the FileDirector server. The connection is automatically set if the WinClient 
was installed via the installation page of the FileDirector server on the client machine. 
 
The URL format is: http://server name/FDinstallation name 
 
whereas: 
server name denotes the name server in the network, where FileDirector is 
installed. 
 
FDInstallation name is the name of the virtual directory of the FileDirector Server 
installation (default: = FileDirector). 
 
With button Test connection the connection to the server can be checked with 
am account known to the FileDirector server. When logged in correct it is dis-
played in a message window. 

Automatically Log-In 
You can specify if you want to log in to the FileDirector using the current windows 
account or if you want to specify a name and password of a valid user account. 
Normally the login should be automatically using the current Windows account, 
because in this case each local cache is assigned properly to the relevant user 
and is only accessible by himself. Which setting should be used in your 
environment is up to your needs and must be configured by an administrator. 
 
To change this setting click to Automatically log-in using current windows 
account in order to switch this setting on or off. 
 

Set up Image 
 
An image can be displayed to visually mark the connections. This improves the 
indentification, especially when dealing with multiple connections. The image has to be a 
bmp file. 

 



112     General settings/Options FileDirector 2.0 

Help 
 

Content / Index/ Search 
These menus open the online help of WinClient. 

Check for updates 
If a new update for WinClient is available on the server an automatic update can 
be performed with this function. This function is available if the installation is 
carried out with the browser installation page of FileDirector. Ask your 
administrator when using this option. 

Info 
Info displays the version number and the licence information of the FileDirector 
server. Certain functionalities might not be available in your system because they 
are optional and are not included in your licence. 

 

Keyboard control 
 

F6 Control box Search 
F7 Control box Edit  
F8 Control box Scan 
Strg + F6 Search results 
Strg + F7 Local Documents  
Strg + F8 Personal folder 
F5 Refresh 
Alt  in index field of control 
box using a keyword list 

Drop down of a keyword list 

Alt  in index field of control 
box using normal field 
 scrolling through last 
entries made 

Drop down of a list of recently used entries (MRU) 
 

Current tab Edit, 
First entry in list is selected, 
storing of changes of return 
in last index field 

In last index field focus jumps to button „Save 
changes and move to next document → pressing 
Return again executes this button  

Perform search (Strg +S) The search is executed using the index currently 
entered. 

Ctrl + A Select all 
Ctrl + T Toggle select 
Ctrl + R Remove selection 
F12 Toggle to fullscreen mode 
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Plug-ins for WinClient 

What is a Plug-in? 
Plug-ins are small additional functions, which have to be explicitly installed on the 
work station. Not every work station needs these functionalities. In this way 
customized functions can be developed to make the system more versatile for a 
special environment. 

Installation of Plug-ins 
 
The plug-ins are located on the FileDirector installation CD in directory plug-ins. 
For installation these files have to be copied into the plug-ins directory of the 
WinClient application directory: 
 
:\Program files\Dieter Spielberg DMS GmbH\FileDirector WinClient\PlugIns\ 
 

Enable the menu of the installed plug-ins 
To use the plug-ins after the installation you need to add the buttons to the menu. This 
can be done with the menu customization if the changes are allowed for the user. If the 
user must not change the menus because of a general client configuration, the 
administrator must activate these buttons in the menu with the client configuration in the 
Enterprise Manager. 

Requirements for OCR Plug-ins 
Since this plug-ins perform an OCR recognition, the Component services and the 
OCR engine must be installed on the server. Note that for usage of OCR a licence 
is required, this function is only available if the work station is connected to the 
server (online). 

Update of the plug-Ins for version 1.5 
The plug-ins were adapted to the FileDirector version 1.5 and have to be updated in case 
you used plug-ins in earlier versions.  
 
 
 

Point and Shoot (OCR Index – Zone recognition) 
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With Plug-in OCR Index it is possible to drag a reading zone and directly move 
the recognized information to an index field – independent if zones for forms 
recognition are configured. This function can also be used for scanned pages 
which are not suited for automatic indexing using forms recognition/OCR.  

Manual OCR zone recognition 
 This button appears in WinClient if the OCR Index plug-in was installed.  

 
 Select the document to be indexed and display it.  
 Activate tab Edit 
 Select the index field to be filled 
 Activate the plug-in button 
 Drag a zone around the information to be read.  
 

OCR-Calculator 
 
Plug-in OCR Calculator allows adding units and prices. If this information is listed 
properly on an invoice, they can be read by OCR and be listed in a calculation 
table. 

Adding of units and prices 
 This button appears in WinClient if the OCR Calculator plug-in was installed.  

For OCR calculator you need a scanned document which lists units and prices in 
columns. Select the document to be read and display it. Activate the plug-in 
button and drag a zone around the listed units and prices. Now a window appears 
where the units and prices are listed in a grid. For quick calculation the entries can 
be modified. 
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CallTo – Reading of telephone numbers 
Plug-in CallTo  also works with OCR recognition functionalities. This plug-in reads 
telephone numbers from a document and filters the reading result in order to obtain a 
valid telephone number.  
The filtered telephone number does not contain hyphens or other formatting characters 
anymore, so that this number can automatically be passed to a defined application using 
the „callto://“ - function from windows. 
 
Such an application could for example be a telephone application like Swyx. More 
information about this application can be found at: http://www.swyx.com. 
 

Setting of a default country code: 
 
<?xml version="1.0" encoding="utf-8"?> 
<configuration> 
 <appSettings> 
  <!--   User application and configured property settings go here.--> 
  <!--   Example: <add key="settingName" value="settingValue"/> --> 
  <add key="CoutryPrefix" value="+49" /> 
 </appSettings> 
</configuration> 
 
If a standard country code should be assigned during recognition, this can be specified in 
the XML file of this plug-in. If “+” or “00” is recognized at the beginning of the number, the 
default country code is not set. 
 

HitListDocumentExport (Export Documents) 
 

This plug-in    can be used to export documents. It creates an export file from the 
selected documents, which can be imported by WinClient.  
 
Select the documents to be imported. The following window appears. A filed separator 
must be defined which is used in the import file. Click to “Export” and select the target 
director for the documents to be exported. 
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A subdirectory named like the cabinet ID is created in the selected directory. The 
documents are written as subdirectories named with the document ID. Additionally and 
index file with suffix “.dat” is created, which contains the index data listed with the relevant 
TIFF files: 
 
Example for 20050718_155717.dat: 
 
Rita,Meier,,,.\ad5959b5-c886-4b7d-bab2-84c459bc11e2\20050715 13429991.TIF 
Rick,Roll,,,.\b2442692-33b9-4fb2-97d9-e3cb62657395\20050715 13429835.TIF 
Ina,Mock,,,.\b8e814a1-0d05-44d7-9834-e5621e0b4bb3\20050718 15370147.TIF 
 
Hint:  
An export with this plug-in exports the last version of a document – without revisions and 
annotations. 
 
To import this data see section → Import documents 
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Global Count (manual global counter) 
With the plug-in „Global count“ a counter can be set manually.The counter of an optional 
field is saved in the table “settings” of the configuration database FD_Config. The counter 
is stored in the column FD_Key with the key “GloblaCountPlugIn”. 
 
 

 
 
The field must be defined in the XML file of the plug-in. 
 

 
 
The value of the database counts up to 1. The field also can contain alphanumeric and 
corresponding values count up like ‘abx’ -> ‘aby’ -> ‘abz’ -> ‘aca’ … 
 
If no value is found in the database (first use) ‘0’ will be set. The value can be changed in 
the database with the SQL Enterprise Manager. 
 
Hint: 
This counter doesn’t need a field with the properties „increment (global)”, because this is 
an automatic server function. 
 

Usage in WinClient 

 After the installation of the plug-in this button is available. 
When the XML file is configured with a valid field, it is filled with the next counter with 
each click on the button. 
 
When multiple pages are to be entered with the same counter close the window of the 
current document and mark several documents. By using the button all selected 
documents will be filled with the counter. 
 
 
 
 
 
 

ResponseWriter (generate response writings) 
 

The plug-in “Response Writer” is meant to fill an automatic response writing with the 
index data of an archived data record or with the index data of a linked data record.  
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Example 
You have two document types:  
 
1) One document type with address data of customers and a customer ID as a clear 
connection.  
 
CustomerID, Address, Name, Email, Phone, Street…etc. 
 

 
 
2) Another document type with invoices containing customer ID as well.  
 
CustomerID, Invoice number, Date …etc. 

 
 
Now you want to generate a response to a customer for an invoice out of the second 
document type whereas the address data of the first document are to be filled in 
automatically into the correspondence. 

Installation 
Copy the plug-in “ResponseWriter“to the program directory of the WinClient. This 
directory also contains the XML-file “DSDMS FileDirector ResponseWriter.xml” which has 
to be edited for configuration.  

Configuration 
Please aquire the CabinetID, the document type  ID of the first document type with 
detailed address data (DetailsDocType), the fieldID of the connection field (here: 
CustomerID) and the ID’s of the fields from both document types you want to adopt later 
on to the correspondence.  
Please open the configuration file „DSDMS FileDirector ResponseWriter.xml“ and fill in 
the appropriate values: 
 
<?xml version="1.0" encoding="utf-8"?> 
<Configuration> 
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         <Cabinet ID="055CF7ED"> 
 <Settings key="ConnFieldID" value="1E074F71" /> 
 <Settings key="DetailsDocType" value="2C2B91E8" /> 
 <Settings key="TemplatePath" value="D:\Templates\EDocs\" /> 
 <ShowDetailColumns FieldID="90511262" /> 
 <ShowDetailColumns FieldID="1E074F71" /> 
 <Mapping FieldID="90511262" Name="«°First name°»" /> 
 <Mapping FieldID="1E074F71" Name="«°Name°»" /> 
 <Mapping FieldID="E4A1A0A2" Name="«°Address°»" /> 
 <Mapping FieldID="2B11B6E4" Name="«°Postcode°»" /> 
 <Mapping FieldID="E13A67C0" Name="«°City°»" /> 
 <Mapping FieldID="458C3749" Name="«°Customer No.°»" /> 
 <Mapping FieldID="CCA3175B" Name="«°Invoice No.°»" />   
         </Cabinet> 
</Configuration> 
 
The following <tags> must be filled in file: 
Cabinet ID   
ConnFieldID  = Connection field between document types  
DetailsDocType = Document type of the address data (details) 
TemplatePath = Path for the templates  
ShowDetailColumns = Fields for the listed contact persons in the mask „Select  
       details“ if several entries are available for one customer ID 
<Mapping FieldID="90511262" Name="«°First name°»" /> 
The mapping fields are fields which contents are filled in later on into the correspondence 
and are “extracted“ from the document type. You can either fill in the ID in this way 
[FD_3795A51F] or the definition which was set as name of the field: «°First name°». 
 
The address field of a word-file which is to be filled with the defined fields can look like 
this, for example (here: Testvorlage.doc): 
  

 
 
 
 

Procedure/usage after configuration: 
Select an invoice a click on the icon   for the plug-in. 
 

 
[FD_90511262]  [FD_1E074F71] 
[FD_ E4A1A0A2] 
[FD_2B11B6E4] [FD_ E13A67C0] 
 
 
Your invoice:   «°Invoice number°» 
 
 
Dear Sir or Madam, 
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Since our example provides for the customer number 1111 two entries respectively two 
contact persons, a mask for selection is provided.  
 
Selecting one contact person and pressing OK you can choose a template from the 
template path set up in the XML-file which is filled with the accordingly configured fields.  
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ClearUI – Reset user interface  
 If the plug-in „ClearUI“ (Clear User Interface) is installed in the plug-in of the 

WinClients, you can reset the user interface by using the brush to provide a better 
overview. Using this function all index fields are cleared and the opened documents are 
being closed. Only the local list will remain opened and only the new or non-checked in 
documents are shown.  
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Create Retrieval CD/DVD * 

What is a Retrieval CD/DVD? 
Data including a retrieval facility can be exported to CDs or DVDs. These data can be 
used for retrieval without any usage of a FileDirector Server. A special retrieval client is 
available to control these data. This is a very easy way to provide data for retrieval from a 
FileDirector Server to somebody who has no access to a FileDirector infrastructure.  
 

Requirements/Tickers 
A so called ticker is required to create a retrieval CD or DVD. These tickers can be 
purchased in blocks and they are stored in the FileDirector program licence. Any number 
of documents can be exported and added to an assembly of data. If the required data 
have all been collected, this collection must be licensed with a ticker. Only when this 
ticker licensing has been executed, the data can be processed by the retrieval software. 
 
A licensed CD or DVD can copied without limitation and without requiring new tickers. If 
data is amended to an existing licensed collection, a new ticker is needed 
If a collection of documents needs more space than available on the relevant disk (CD or 
DVD), the data are divided into several directories. These directories can be opened by 
the retrieval client as separate cabinets. For each directory an own ticker is required.  
 
Hint: 
The number of available tickers can be displayed in WinClient under Menu „?” – Info. 
 
In order to purchase tickers please contact your FileDirector dealer. 
 

 

Creation of a retrieval CD 
If you want to export documents to a retrieval CD, select the documents to be exported. 
Afterwards go to file → Export → Retrieval CD/DVD.  
 
If documents from different document types should be exported, they can be assembled 
step by step without having to licence each time after exporting. It is possible to create a 
document list containing more documents than the currently set maximum number of 
displayed documents.  
A number of documents can be added to an exported cabinet at any time. If the exported 
cabinet was already licensed with a ticker, a new ticker will be necessary. When it has not 
been licensed by a ticker yet, any number of documents can be added and you need a 
ticker for licensing only at completetion. 
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Hint: 
The maximum number of documents to be displayed on a document list is set on the 
server. An administrator can specify the maximum number of documents to be listed on a 
document list.  
(See → „Number of hits “in Installation manual) 
 

 
 
With these settings a directory is created containing a cabinet directory holding the data 
and a file Cabintes.XML in the same path. 

Target folder 
The exported data are stored in the target folder. A subdirectory with the cabinet ID as 
name is created. A file CABINTES.XML is created, which is later opened by the retrieval 
client. Additionally a licence file and some more XML files are created, which describe the 
contents of the cabinet. 

Include revisions / history 
If revisions should be exported as well, this option can be clicked. Please note that the 
user exporting the data should have the right to display revisions. Otherwise the data can 
not be exported correctly. 
 
Hint: 
The export of full text is not supported. 

New target folder after: 
The size of the target directory is specified here. The size of the XML files is taken into 
account during calculation of the estimated necessary size.  
Please note to reserve some space on the export disc if the retrieval client software 
should also be copied to the disc. 
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General information 
The companies name and the name of the user exporting the data can be stored here. 

Certificate 
When using a certificate the export can be executed with an electronic signature. 
In order to use this feature, certificate services must be available in the domain (Public 
Key Infrastructure - PKI). A signature ensures that the exported data are created from a 
trusted source. 

Media ID 
Each new CD carries a unique number, the media ID. Using this, a disc can be identified 
as the original one. The previous, actual and next media ID can be specified here.  

Licence FD Retrieval 
This option puts a licence file to the exported cabinet data. If the exported data collection 
is bigger than the space specified, a new subdirectory is created with a new cabinet 
directory. For each directory a ticker is used for licensing. 

Create a CD/DVD 
FileDirector does not contain or control CD/DVD software, the exported data cannot be 
written directly to CD/DVD. Data are always written to an export path, which should not 
exceed the space available on the disc to be written. Even the exported data have been 
licensed; this collection of data can be written to CD/DVD. 
 
 

FileDirector Retrieval Client 
A special retrieval Client is necessary to retrieve the data from a disc. This retrieval client 
must be available for the people, which want to use this disc. The retrieval client can 
either be written additionally to the disc itself or be sent to the users by other means. 

Installation 
On the FileDirector installation CD the retrieval client can be found in directory \Setups 
FileDirector Retrieval Setup.msi. 
For installation log on to the system as administrator user and execute the *.msi –File. 
Follow the installation instructions displayed on the screen.   
 

  
After installation is finished the displayed icon can be found on the desktop. Double 
clicking this icon starts the FileDirector retrieval client. 
 
Hint: 
FileDirector Retrieval Client can also be installed on a computer having FileDirector 
WinClient installed. 
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Open cabinet with retrieval client 
After starting retrieval client a dialogue for opening of a file appears. Now file 
Cabinets.xml must be opened, which was created during export. An exported cabinet can 
only be opened by retrieval client if it was licensed before. 
FileDirector retrieval client generally is comparable with a limited WinClient, i.e. it has less 
functions. Therefore descriptions about the functionalities can be taken from the 
WinClient documentation. 
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The local cache 

 
In the local cache all new scanned, checked out, downloaded or only viewed documents 
are saved automatically. 
 
In version 1.4 or later only the actually displayed pages of a document will be downloaded 
and not all pages of the document. Therefore the time to load is much shorter when you 
are working with large documents. If you want to work offline with the documents, please 
read the section “The offline mode”. 
 
Hint: 
The local cache is automatically created. Here no manual or other changes should be 
made. This can lead to errors during the start of the WinClient or the local list can not be 
displayed anymore. 
 

Storage location 
After a default installation the local cache is in the folder \FileDirector in “My documents” 
of every user. The administrator can move this folder to another folder if e.g. server 
profiles are used (see installation guide). 
 

Structure of the local cache 
In the folder FileDirector for every logged-in user the settings of the WinClient are written 
to a folder. In this user folder a folder with the ID of the cabinet will be created for every 
opened cabinet. The file “docmanager.xml” contains a list of the documents. 

The documents with the data are saved in a folder, which contains the revisions 
and pages in a folder \files. 

Cache is deleted automatically 
With the setting in Extras→Options →Cache “Purge cache on program exit/log-out”. All 
documents which are viewed and not visible in the local list are deleted in the local cache. 
In the file “Docmanager.xml” these documents are labeled with the entry 
<IsTemp>true</IsTemp>. All local and checked-out documents persist. 
 
If the local cache, that means the folder “FileDirector”, is completely deleted, it is new 
created with an empty local list after restarting the WinClient. When the file “settings.fdl” 
was also deleted, the URL connectionstring to the server must be entered at the first start 
of the WinClient. 
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Office Link 
The folder Office Link is created when you use the component service. 
Here are saved documents which are archived with the index capture mask, e.g. 
documents are archived from the windows explorer with the command “send 
to…FileDirector”. 
 

Component Service 
The Component service is installed to manage the different processes. It monitors the 
process “Edoc Engine” and the process “IPRO Engine”. The Edoc engine and contains 
the stellent viewer which can display electronic documents (see → Document formats 
that can be displayed). The IPRO Engine enabled the OCR recognition and is installed 
with the “Western OCR Engine”. 
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Document formats that can be 
displayed 

Document formats 
Together with the Component Service the Outside In Stellent Viewer is installed as he is 
able to display different file formats without the corresponding application needs to be 
installed. 
 
Via the following web site current supported formats can be downloaded as pdf-file. 
 
http://www.oracle.com/technologies/embedded/docs/OutsideIn-Files-datasheet.pdf    
 
Hint:  
The Stellent Viewer Version 8.2.0 has been part of the Component Service since 
10.12.2007 
 
(The formats are not listed anymore for updating and copyright reasons.) 
 

Avoiding Stellent Viewer in WinClient 
 
When using formats that are not supported by the Stellent Viewer or having trouble with 
displaying these files via the WinClient, the Stellent Viewer can be avoided for these 
formats. 

Settings for the Client 
To apply this setting to a single client, add an entry to the configuration file app.xml. 
  

 
 
This file is stored in the program path of WinClient. C:\Program Files\Dieter Spielberg 
DMS GmbH\FileDirector WinClient. 
 
 
In this file app.xml you find the following entry:  
 
  <appSettings> 
    <add key="NoStellentFor" value=".xml;.htm;.html;.mht" /> 
  </appSettings>  
</configuration> 

http://www.oracle.com/technologies/embedded/docs/OutsideIn-Files-datasheet.pdf
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Add the format that is not to be used by the Stellent Viewer. 
 
Hint: 
Please keep in mind that this setting will be overwritten after an update. When this setting 
shall remain after an update, the setting must be done before the installation on the 
server in app.xml. 
 

Settings for all Clients before the installation 
You can find a file named app.xml in the installation data. This file contains the entry 
described beforehand, too. If this entry is added on the server (directory 
inetpub\wwwroot\FileDirector\Setups\WinClient\app.xml), the entry is written into the 
app.xml of the program directory. 
  
Hint: 
It is insufficient to add this entry only to the app.xml in the WinClient program path on the 
client, because the file will be overwritten by the server app.xml when the next update is 
executed. The settings on the server must be done by an administrator.  
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